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A	63
a, an	63
about, around	63
accept, except	63
access	63
acknowledgment	64
affect	64
afterward	64
aid, aide	64
allude, elude, refer	64
allusion, illusion	65
among, between	65
ampersand (&)	65
anticipate, expect	65
assure, ensure, insure	66
at risk, at-risk	66
average	66
B	66
bad, badly	66
benefit	67
beside, besides	67
between, among	67
bi, semi	68
biannual, biennial	68
birthdate, birth date	68
both, and	68
breastfeed	68
broadcast	69
by-product	69
C	69
can, may, might	69
cancel, canceled, canceling, cancellation	69
capital, capitol	70
caregiver, caregiving	70
carry over, carryover	70
chair	70
checklist	71
check up, check on, checkup	71
child care	71
child care center	71
children with special needs (and disabilities)	71
commit, committed, committing, commitment	71
common sense, commonsense	72
compare to, compare with	72
compatible	72
complement, compliment	72
comprise	73
consensus	73
continual, continuous	73
cost effective, cost-effectiveness	73
coursework	74
credentialed, credentialing	74
crisis, crises	74
criterion, criteria	74
cross section, cross-section, cross-sectional	75
crosswalk	75
current, currently	75
curricula	75
cut back, cutback	76
D	76
data	76
database	76
disinterested, uninterested	76
doctorate	76
download	77
due to	77
E	77
each	77
ensure, insure, assure	77
ex officio	77
expect, anticipate	78
expel, expelled, expelling	78
explicit, implicit	78
F	78
fact	78
farther, further	78
feasible	79
fewer, less	79
field test, field-test	79
fieldwork	79
file name	79
firsthand, first-hand	80
fiscal, monetary	80
fiscal year	80
flagpole	80
flowchart	80
foldout	81
following, after	81
follow up, follow-up	81
full time, full-time	81
fundraising, fundraiser	82
further, farther	82
future	82
G	82
gift	82
gigabyte	83
good-bye	83
good will, good-will	83
H	83
health care, health-care	83
Hispanic	84
homepage	84
I	84
impact	84
imply, infer	84
in, into, in to	85
inconsistent	85
incorporate	85
indexes, indices	85
indispensable	85
individual	86
infant	86
in-service	86
insure, assure, ensure	86
intra	86
it’s, its	87
J	87
job site	87
judgment	87
junior, senior	87
K	88
kick off, kick-off	88
kindergarten, kindergartner	88
L	88
last, latest, past	88
Latino	89
lay, lie	89
less, fewer	89
liable	89
liaison	89
lie, lay	90
lifelong	90
life-size, life-sized	90
life span	90
lifestyle	90
likely	90
linage, lineage	91
local	91
log off	91
logon, log on	91
M	92
majority	92
makeup, make up	92
man, mankind	92
markdown, mark down	92
markup, mark up	93
may, might, can	93
mean	93
media	93
mediate	94
megabyte	94
mid-range	94
middle grades	94
might, may, can	95
multi	95
N	95
native	95
Native American	95
none	96
nonprofit, non profit, non-profit	96
non-negotiable	96
norm	96
note taker, note taking	96
O	97
occur, occurred, occurring, occurrence	97
officeholder	97
offsite, off-site	97
online	98
on-site	98
oral	98
P	98
paperwork	98
part time, part-time	98
password	99
PDF	99
people	99
per pupil spending	99
percent	99
permissible	99
picture book, picture-book	100
Philipino	100
P.O. Box	100
podcast	100
policymaker, policymaking	101
postsecondary	101
post-test	101
prekindergarten, pre-K	101
prenatal	101
preschool	102
presently	102
president-elect	102
principal, principle	102
prior to	102
privilege	103
problem solving, problem-solving	103
pupil	103
R	103
recordkeeping	103
reevaluation	103
reteach	104
S	104
school-age	104
school children	104
school day	104
school site	104
school teacher	104
school time	105
school year	105
semi, bi	105
service-learning	105
sign-off, sign off	106
Social Security	106
socioeconomic	106
spreadsheet	106
staff	106
standards-based	107
statewide	107
supposed to NOT suppose to	107
T	107
teamwork	107
textbook	107
than, then	108
that, which	108
their, there, they’re	108
then, than	109
through	109
time frame	109
time line, timeline	109
timesaving	109
toll-free	110
toolbox	110
tool kit	110
toward, towards	110
twenty-first century	110
U	110
unanimous	110
under way, underway	111
up close	111
update	111
upon	111
up-to-date, up to date	111
use, utilize	112
user-friendly	112
user name	112
V	112
verbal	112
versus	112
vice president	112
videotape	113
W	113
webcast	113
webinar	113
webpage	113
website	114
well-being	114
which, that	114
word of mouth, word-of-mouth	114
workbook	115
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workforce	115
workgroup	115
workload	115
work order	115
workplace	116
work plan	116
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workshop	116
work site	116
Y	117
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Background

The goal for all First 5 California publications, whether in print or online, is to communicate clearly and concisely with our varied audiences. A unified, consistent style and presentation conveys certainty and empathy for our intended audiences. We need to provide easy-to-read and easy-to-find information that our audiences want and need, free of inconsistencies that distract from the content. 

Language style can evolve and change over time. As a result, some of the advice in this Writing Standards Style Guide (Guide) may differ from what you learned in school or have used at other organizations. The information in this Guide represents current uses and preferred choices for First 5 California writing. Communicating with a unified style and presentation not only enhances the quality and effectiveness of our work, but helps engender the confidence and trust of our audiences. 

Scope

While this Guide is not intended to answer every question you have about writing and formatting documents and Web content, it should be your first resource. If you do not find the answer you are looking for here, you may refer to other resources, such as:

Spelling and hyphenation: Merriam-Webster’s Collegiate Dictionary, eleventh edition. Available online at webster.com and onelook.com. 

Style, formatting, and grammar issues: The Gregg Reference Manual, 10th edition, William A. Sabin and the Associated Press Stylebook, editor, Norm Goldstein. 

If there is a conflict between the Guide and other resources, follow the direction in this Guide to ensure consistency. 

Abbreviations and Acronyms

Abbreviations

An abbreviation is a shortened form of a word or phrase. Generally, an abbreviation consists of a set of letters taken from a group of words (e.g., U.S. for United States, E.U. for European Union, and U.N. for United Nations).

Acronyms

An acronym is a word formed from the first letter (or letters) of a series of words (e.g., Comprehensive Approaches to Raising Educational Standards [CARES] Plus). The choice between using a or an with an acronym or abbreviation depends on how it is spoken rather than whether the first initial is a vowel or consonant (e.g., a NASA scientist; an HTML class; an FTE; a UFO).
It is critical to know your audience. To the extent possible, avoid using abbreviations or acronyms your reader will not recognize. Although they are useful to avoid repetition of organizations and programs with lengthy names, their overuse can be disruptive. 

Spell out the abbreviation or acronym on the first use and follow with the abbreviation or acronym in parentheses. If the subsequent reference is too far away from the text where it originally was spelled out for the average reader to remember, spell it out again. An exception to this standard applies if you are writing to an audience familiar with frequently used acronyms (e.g., CARES Plus, CSP). In this case, you may use the acronym without spelling it out on the first use. 

Do not use abbreviations or acronyms in titles, headings, or salutations. 

Examples
Acceptable Abbreviations

Southeast (SE)		Company (Co.)		Miss (Ms.)
Northwest (NW)		Corporation (Corp.)		Misses (Mrs.)
Ante Meridiem (a.m.)	Incorporated (Inc.)		Mister (Mr.)
Post Meridiem (p.m.) 	Doctor (Dr.)			Junior (Jr.)
Notes

To make an acronym plural, add a lowercase s (e.g., ABCs). To form a singular possessive, add an apostrophe s (e.g., OSHA’s regulations). If the acronym ends in s, add an apostrophe after the s to make the acronym possessive (e.g., CARES’). To form the plural possessive of an acronym, add s’ to the singular form (e.g., the CPAs’ meeting). 



Active vs. Passive Voice

Voice refers to the relationship between, and the order of, the subject and verb. 

Active 

In active voice, the subject acts (x does y). Active voice is specific and easier to read and understand than passive voice. Active voice communicates more dynamically and results in shorter and stronger sentences. Use an active voice whenever possible. 

Passive

In passive voice, the subject is acted upon. Passive voice often is dull, ambiguous, or seems to avoid responsibility. Sometimes the subject completely disappears in the passive voice. Passive voice often leaves the reader asking who did what. Passive voice places the burden on the reader to fill in the blanks or figure out the subject-action sequence, and can be wordy and cluttered. Use a passive voice when the subject is unknown or insignificant compared to the action and what is acted upon, or when avoiding assignment of blame. 

Examples
Active vs. Passive Voice

Active: Financial experts performed an investment study.
Passive: A study on investments was performed by financial experts. 

Active: First 5 California will fund your program once it receives and processes your completed application. 
Passive: First 5 California cannot fund your program until your completed application is received and processed. 

Active: The cleaning crew vacuums and dusts the office every night.
Passive: Every night, the office is vacuumed and dusted by the cleaners. 

Active: You did not complete the form; therefore, we are denying your application. Rewrite to eliminate blame as:
Passive: The application is denied based on an incomplete form. 


Notes

Read your work with a focus on passive indicators like the verbs be, is, are, have, had, has, and been. Look for words ending in ed and tion to recast as active verbs.

Appointed or Elected Officials (Address Format)

Formatting Addresses 

When formatting addresses for appointed or elected officials, write or type the capitalized proper title in the first line. Place the official’s position in the second line. Position the address in the third line. Write the city, state, and ZIP code in the fourth line. 

Examples
Correct Address Format for Appointed or Elected Officials

Title: 						The Honorable John Doe
Position:					Governor of California
Address:					300 Capitol Mall, Suite 342
City, State, and ZIP code:			Sacramento, CA 95814

Correct Address Format for State Elected Officials

The Honorable John Doe			The Honorable John Doe
Governor of California			State Treasurer
State Capitol					P.O. Box 942809
Sacramento, CA 95814			Sacramento, CA 94209

Dear Governor Doe:			Dear Treasurer Doe:

The Honorable John Doe			The Honorable John Doe
Lieutenant Governor 			Attorney General
State Capitol, Room 1114			P.O. Box 94244-2550
Sacramento, CA 95814			Sacramento, CA 94209

Dear Lieutenant Governor Doe:		Dear Attorney General Doe:

Correct Address Format for State Elected Officials (Continued)

The Honorable John Doe			The Honorable John Doe
Secretary of State				Insurance Commissioner
1500 11th Street				300 Capitol Mall, Suite 1700
Sacramento, CA 95814			Sacramento, CA 95814

Dear Secretary Doe: 			Dear Commissioner Doe:

Correct Address Format for Senate pro Tempore

The Honorable John Doe, President pro Tempore 
California State Senate 
State Capitol, Room # XXX
Sacramento, CA 95814 

Dear Senator Doe:

Correct Address Format for Assembly Speaker

The Honorable Jane Doe, Speaker
California State Assembly
State Capitol, Room # XXX
Sacramento, CA 95814

Dear Speaker Doe:

Correct Address Format for Senator or Assembly Member

The Honorable John Doe			The Honorable John Doe
California State Senate			California State Assembly
State Capitol, Room # XXX		State Capitol, Room # XXX
Sacramento, CA 995814			Sacramento, CA 95814

Dear Senator Doe:				Dear Assembly Member Doe:


Correct Address Format for Members of Congress

The Honorable James Doe			The Honorable John Doe
United States Senate			U.S. House of Representatives
Address					Address
Washington, DC 20510			Washington, DC 20510

Dear Senator Doe:				Dear Representative Doe:

Correct Address Format for Appointed Education Officials

John Doe, Secretary of Education
U.S. Department of Education
400 Maryland Avenue, SW
Washington, DC 20202

Dear Secretary Doe:

Correct Address Format for the First Lady

Jane Doe, First Lady
State Capitol
Sacramento, CA 95814	

Dear First Lady Doe:
Appointed or Elected Officials (Capitalization) 

Capitalizing the Titles of Appointed or Elected Officials

Capitalize a person’s title when it follows his or her name on an address or signature line. Capitalize government officials’ titles when the titles precede their names. Capitalize any title when it is used as a direct statement or address to the individual. Capitalize abbreviated titles when they precede or follow the name of a specific person and spell out these abbreviations when the words are used in quotations. Capitalize a title when it is a description following the name. Do not capitalize a qualifying word preceding a title. 


Examples
Correct Capitalization for Appointed or Elected Officials

Camille Maben, Executive Director, addressed the audience. 

Executive Director Camille Maben addressed the audience. 

Executive Director Maben will address the Commission.

President Obama signed the legislation. 

Governor Jerry Brown is California’s governor. 

Today’s speaker is former President Carter.

Mr. Obama was elected president in 2008.

Kamala Harris, Attorney General, held a news conference. 
[bookmark: _Toc415144307]Capitalization

[bookmark: _Toc415144308]General Guidelines 

While it is not possible to provide rules to cover every capitalization situation, if we consider the documentation purpose and underlying principles of what we are writing, we will attain a considerable degree of uniformity in First 5 California written works. 

Use lowercase unless there is a specific reason for capitalizing. Use italics rather than all uppercase to emphasize a word. Be careful not to overuse italics as they can be difficult to read. Also, do not use all uppercase in headings and subheadings. Instead, use larger font size to indicate content hierarchy. 

Capitalize proper nouns that identify a specific person, place, or thing; common nouns that are part of proper names; and the first word of a quoted sentence. 


Use lowercase for common nouns when they stand alone and for common noun plurals that follow a proper noun. Capitalize geographic coordinates that refer to a specific region, and counties or regions that indicate a geographic area. 

Capitalize Federal and State only when used as part of an official agency name or in government documents where these terms represent an official name. 

Capitalize Commission when referring to the First 5 California Children and Families Commission and when naming a specific county commission. Capitalize Commissioner when referring to a specific commission member. Use lowercase when making a general reference to First 5 county commissions. 

Capitalize Assembly when referring to the California legislative house and assembly member when preceding a legislator’s name. 

Capitalize Legislature when preceded by the name of a state or referring to a specific state’s legislature. 

Capitalize both words in a hyphenated word when it appears in a title or e-mail subject. 

[bookmark: _Toc415144309]Examples
Correct Examples of General Capitalization Guidelines

Jennifer and Mary visited California this year and hope eventually to see the Eiffel Tower. 

He said “Some people like ice cream even when it is cold outside.”

I have been to both the Sacramento and American rivers. 

The Democratic Party met on the American River in San Joaquin County. 

I live in California, but was born in the South.

Lake County is in the Bay Area Region.

The State Franchise Tax Board is preparing for tax season.

The state may have to impose furloughs.

The California Children and Families Commission advocates early education.
Correct Examples of General Capitalization Guidelines (Continued)

The First 5 Sacramento County Commission hosted a seminar for new parents. 

The First 5 county commissions await a new program update. 

Last week, Commissioner Smith met with a group of constituents. 

Republican and Democratic parties are represented here today. 

Beth Gaines is a member of the California State Assembly. 

John Doe accompanied Assembly Member Ken Cooley to the luncheon today. 

The California Legislature met in a special session today.

Evidence-Based Practices
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[bookmark: _Toc415144310]General Guidelines for not Capitalizing

Running text is defined as the body of text in a document, magazine, or newspaper, which is different from the headings, subheadings, headers, footers, and titles. The following should not be capitalized in running text unless used as the first word in a sentence. 

[bookmark: _Toc415144311]Examples
Do Not Capitalize the Following
Unless Used as the First Word in a Sentence

a, an, the, but, and, for, nor, or, for, of, in, out, up, on, over 
(articles, conjunctions, or prepositions with four or fewer letters)

fax 	a.m. or p.m.		grade or grade-level		

figure or figures 		appendix or appendices		chapter(s)

to in an infinitive phrase (How to Measure Success in School)

governor unless preceding a personal name (e.g., Governor Brown)

greater unless it denotes a city (e.g., Greater Los Angeles)

act unless referring to a specific legislative act (e.g., the Taft-Hartley Act)
[bookmark: _Toc415144312]Title Case

Title Case is a convention used in capitalization that requires writers to capitalize a title’s first and last words, and all major words in between. This convention also applies to subtitles, headings, and headlines. Not all style guides agree on what distinguishes a "major word" from a "minor word." For First 5 California purposes, when using Title Case, capitalize all words in the title except for articles (a, an) prepositions (in, on, over, by, for, at) and conjunctions (and, but, for, nor, yet, so) with four or fewer letters.

It is imperative to maintain consistency with Title Case throughout a document. When in doubt, The U.S. Government Printing Office Style Manual recommends capitalizing all words in publication and document titles, except a, an, the, at, by, for, in, of, on, to, up, and, as, but, it, or, and nor.

[bookmark: _Toc415144313]Examples
Correct Title Case

Research Shows 90 Percent of a Child's Brain Develops in the First Five Years of Life 

Early Start Family Resource Centers: The Heart of Early Start
[bookmark: _Toc415144314]Cross References

Cross references direct readers to related information to help amplify and add to what they are reading. You may cross reference information in the same publication or in external sources. For clarity and consistency, first state what the reader needs to look for and then where they will find it. 

Do not rely heavily on cross references as too many may confuse the reader. If you repeat information, state where it already was included in the document (e.g., as described earlier in “Capitalization”).

Avoid specific page number references. They are laborious to create without an automated page bookmark function, and if the reference is too specific, you risk inaccuracy with future text changes. 

[bookmark: _Toc415144315]Cross References in the Same Document

Do not use above or below to reference material unless it is visible on the same page and will stay that way after final formatting. 

Place topics and chapters in quotation marks when including as a cross reference. 

[bookmark: _Toc415144316]Examples
Correct Cross References in the Same Document

For additional details, see “Proofreading Tips” later in this section. 

For a list of First 5 California county commissions, see “County Commissions” at the beginning of this document.”

For more information, see “Fonts” later in this document. 
[bookmark: _Toc415144317]Cross References to a Separate Document

When referring to information in another document, refer to the document title, without a specific topic or section name as these may change. Italicize document titles, including handbooks, guides, and brochures. 

[bookmark: _Toc415144318]Examples
Correct Cross References to a Separate Document

For additional information about readiness assessment requirements, see the Readiness Assessment and Technical Assistance Guide.

For a complete copy of First 5 California’s Prevention of Sexual Harassment policy, refer to the First 5 California Handbook.
[bookmark: _Toc415144319]Cross References to Internet, E-mail, or Website Addresses 

Always display the First 5 California website address as it appears in the browser. When referring to a website, do not drop the www at the beginning of the address. Be sure to use the letter case (capital or lower case) shown in the Web browser. Also, be sure to hyperlink the Web address. If an Internet address falls at the end of a sentence, place a period at the end. If an address must break between lines, move the address to the next line or rewrite the sentence to avoid breaking a URL.

[bookmark: _Toc415144320]Examples
Correct Cross References to Internet, E-mail, or Website Addresses

You can find information on First 5 California programs at www.ccfc.ca.gov. 

For more information about learning activities, please see our Parents’ site at www.ccfc.ca.gov/parents. 
[bookmark: _Toc396974473]

[bookmark: _Toc415144321]Dates
[bookmark: _Toc415144322]General Guidelines 

Spell out the day of the week and the name of the month. Do not use the numeric abbreviation for dates. Be consistent in date format throughout the document. 

Do not separate the year with a comma when a phrase includes only the month and year, unless it is in an introductory clause. 

Insert a comma before and after the year when a phrase includes the month followed by the day and year. In other words, if in the middle of a sentence a comma precedes the year, always place a comma after the year.

Do not use st, th, nd, or rd after a numeric value, when using the month, day, and year. 

Do not use an apostrophe before the s in numerically depicted decades or centuries. 

[bookmark: _Toc415144323]Examples
Correct Date Format

In May 2013, I started a new job. 

Today is Tuesday, April 10, 2014. 

Jane graduated in June 2007. 

Our staff meeting is scheduled for Thursday, September 10, 2014, at 2:00 p.m. 

Today is Friday, April 13. 

We will go to the meeting on the 20th. 

1990s, the 1900s, the ‘90s
[bookmark: _Toc396974474]

[bookmark: _Toc415144324]Formatting 

[bookmark: _Toc415144325]General Guidelines 

A document’s appearance, or formatting, gives it a specific look and feel. A document’s appearance helps or hinders the reader’s ability to find information and comprehend the material. Present all text and graphics in a consistent manner, using plenty of white space. Use tables to organize complex materials. 

[bookmark: _Toc415144326]Fonts

First 5 California uses the following fonts: 

· Arial 12-point font for body text, as demonstrated throughout this document 

· Bolded Arial 14-point font for first-level headings, as demonstrated throughout this document. 

· Bolded Arial 12-point font for second-level headings or subheadings, as demonstrated throughout this document. 

· Underlined Arial 12-point font for third-level headings or subheadings. 

Do not italicize headings or subheadings. 
[bookmark: _Toc415144327]Examples
Font Types

Child Signature Program

Annual Meeting

Dates and Location

The Annual Meeting will be held on May 1, 2015, at the DoubleTree Hotel in Sacramento. 


[bookmark: _Toc415144328]Headers and Footers

Letters should include a header that shows the subject, date, and page number for every page after page one.

Document footers may include the name of the document or publication, and/or a publication date, and must include the page number located in the center of the bottom of the page, as demonstrated throughout this document. 

[bookmark: _Toc415144329]Inserting a Header or Footer (Instructions)

You may insert a header or footer using the Insert menu in Microsoft Word. First click on the Insert tab. Next, click on the Header or Footer drop-down option in the Insert tab ribbon. Use the scroll bar to view Header or Footer format options (e.g., Conservative). Finally, click on your preferred Header or Footer format. 

[bookmark: _Toc415144330]Headings and Subheadings

Headings and subheadings are guideposts for the reader to quickly and efficiently navigate a document. Headings and subheadings should be concise and clearly set the readers’ expectations about the text that follows. Make sure the first sentence in the leadoff paragraph is clear and stands alone.

Avoid using an article (e.g., a, an, the) to begin a heading or subheading. Maintain heading and subheading consistency within a section and document. Do not italicize headings or subheadings. 

Use parallel structure for headings and subheadings and try to keep headings on one line. If you have to break headings or subheadings into two lines, make sure the break does not detract from readability. Also, make sure the break occurs after a whole word, not a hyphenated word, and capitalize both words in a hyphenated word. 

Use Title Case, as described in the “Capitalization” section earlier in this document, for headings, subheadings, and publication, program, and form titles (also referred to as proper form names). Italicize proper form titles/proper form names. Use lowercase and regular type for the word form. Capitalize the first and last word in a heading, subheading, or title, regardless of the parts of speech. Do not capitalize articles (e.g., a, an), coordinate conjunctions (e.g., for, and, but, or, to), unless these are the first or last word in a title.




[bookmark: _Toc415144331]Examples
Correct Format for Headings and Subheadings

First 5 California – Future Investments (first level heading)

Long-Term Benefits of Early Childhood Education (first level heading)

Fiscal Year 2014–15 CARES Plus Program Seminar (second level heading or subheading)

Information on CARES Plus and Child Signature Program (third level heading or subheading)
[bookmark: _Toc415144332]Indenting and Text Spacing

In all documents, use only single line spacing (not 1.5 or double) for body text. You may verify line spacing by right clicking on the body text, selecting Paragraph in the dialogue box, selecting the Indents and Spacing tab, and verifying the Line Spacing drop-down says Single. 

Do not indent the first line of each new paragraph. Leave one blank line between paragraphs. Align the text with the left margin, as demonstrated throughout this document. 

Leave one blank line between each bulleted or numbered list item, including between the lead-in sentence and the first list item. 


[image: C:\Users\jhastings\AppData\Local\Microsoft\Windows\Temporary Internet Files\Content.Outlook\WF0HWBP2\20121216_114403.jpg]

[bookmark: _Toc415144333]Examples
Indenting and Text Spacing

First 5 California was created by voters under Proposition 10 to recognize children’s health and education is a top priority, especially in the early years of development. 

Research shows 90 percent of a child’s brain develops in the first five years of life. Making those years count is what First 5 California is all about. Our focus is to educate parents and caregivers about the important role they play in their children’s first years. 

The Preschool Expansion Grants program seeks to:

1. Implement and sustain high-quality preschool programs that reach and serve additional eligible children in two or more high-need communities

2. Enhance preschool program infrastructure and capacity to deliver high-quality preschool programs

3. Allocate up to five percent of the total federal funds over the grant period for state-level infrastructure to support high-quality preschool programs
[bookmark: _Toc415144334]Italics

Use italics for form and publication titles (e.g., handbooks, brochures). 

[image: https://scontent-b-sea.xx.fbcdn.net/hphotos-xpa1/v/t1.0-9/1918466_1111341909099_2289362_n.jpg?oh=000a21d2ed446ddd43b5b4b50a65faf9&oe=551509E1]Be careful not to overuse italics as they can be difficult to read. If necessary, rewrite text to add emphasis. Do not italicize headings or subheadings
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[bookmark: _Toc415144335]Examples
Correct Use of Italics 

Please complete form P.1/P.1S: CARES Plus Program Participant Application and Certification. 

First 5 California distributes the Kit for New Parents to first-time parents, grandparents, and caregivers. 
[bookmark: _Toc415144336]Page Layout

Use one-inch margins on all sides of a Microsoft Word document (top, bottom, left, and right), as demonstrated throughout this document. 

Unless otherwise specified, use a ragged right margin (align text left), as demonstrated throughout this document. Research indicates that text with a ragged right margin is easier to read than justified text. 

You may validate your page layout by using the Page Layout menu in Microsoft Word. First click on the Page Layout tab. Then click on the Margins drop down option in the Page Layout tab ribbon. Select the Normal option. 

[bookmark: _Toc415144337]Page Numbers

Position page numbers at the bottom of the page, in the center, as demonstrated throughout this document. Typically, page numbers do not include a section or chapter number. 

You may insert page numbers using the Insert menu in Microsoft Word. First click on the Insert tab. Then click on the Page Number drop down option in the Insert tab ribbon. Select the bottom of page option and click on Plain Number 2 to insert page numbers in the bottom center of the page. 

You also may use the Footer Styles feature by clicking on the Insert tab then clicking on the Footer drop down option in the Insert tab ribbon. Use the down arrow to scroll to the Conservative option. Click on Conservative and select the option for the page number at the bottom center of the page. 

Alternatively, you may use a template that automatically formats page numbers. 

You may abbreviate page (p.) or pages (pp.) when referencing a page or pages within body text. 

[bookmark: _Toc415144338]Table of Contents

A Table of Contents (TOC) is just like the list of chapters at the beginning of a book. It lists each section in the document and the page number where that section begins. A basic table of contents might look like Figure 1:
[image: Screenshot of Word 2013]Figure 1
You can manually create a TOC by typing the section names and page numbers. However, this would take a lot of work and would be difficult to maintain if you rearrange sections or add information. First 5 California recommends formatting your document so Microsoft Word can create and update a TOC automatically. 

First, you must apply Heading Styles. This function adds professional text formatting to different parts of a document, along with a hidden layer of organization and structure. 

If you apply a heading style, you are telling Microsoft Word that you started a new part of your document. When you insert a TOC, it will create a section for each heading. In the TOC above, each chapter uses a heading style, resulting in four different sections.

To apply a heading style, select/highlight the text you want to format. Click on the Home tab. Use the down arrow in the Styles dialogue box of the Home tab ribbon to scroll to your desired Style (e.g., Heading 1). Click on the desired Style as shown Figure 2: 

[image: Screenshot of Word 2013]Figure 2


Once you apply heading styles, you may insert your TOC. Click on the References tab. Click on the down arrow in the Table of Contents option in the References tab ribbon. Click on the desired TOC option (e.g., Automatic Table 1) and the TOC will appear in your document. An example follows in Figure 3: 
[image: Screenshot of Word 2013]
Figure 3
As shown in the TOC above, Microsoft Word uses the heading styles in a document to determine where each section begins. Sections that begin with a Heading 2 or a Heading 3 style are nested within a Heading 1 style, like a multilevel list as shown in Figure 4. 

[image: Screenshot of Word 2013]Figure 4


A TOC also creates links for each section, allowing you to navigate to different parts of your document. Press the Ctrl key on your keyboard and click on the heading or subheading (while pressing the Ctrl key) to move to the selected section, as reflected in Figure 5. 
[image: Screenshot of Word 2013]
Figure 5
If you edit or add to the document, it is easy to update the TOC. First, click on the TOC. Next, click on the Update Table tab that appears at the top of the TOC, as seen in Figure 6. Finally, click on Update Entire Table in the dialog box that appears. The TOC then automatically will update to reflect your changes.
[image: Screenshot of Word 2013]
Figure 6


[bookmark: _Toc396974475][bookmark: _Toc415144339]Geographic Terms

[bookmark: _Toc415144340]General Guidelines 

Capitalize the names of countries, languages, words, and phrases that identify distinct areas, regions, places, divisions, and districts of continents when using them as proper nouns or in addresses. Also capitalize names of mountains, ranges, rivers, oceans, islands, and smaller areas within larger locations when used as proper nouns. 

Capitalize compass points and directions when they refer to a specific region or are part of an address. Also capitalize public places (e.g., monuments, parks, and landmarks), street names, and popular and legendary names of places when you use them as proper nouns or in an address. 

Capitalize words or phrases that designate political divisions when used as proper nouns or in an address. 

Use lowercase for geographical features that are not proper nouns. Also use lowercase for direction of travel. 

Do not capitalize common objects with a country or nationality as part of the name. By attaching itself to a common object, the language or country name takes on a new meaning of an everyday object and no longer is specific to the country or language. 

[bookmark: _Toc415144341]Examples
Correct Format for Geographic Terms

My father was born in Germany. 

I learned to speak French in high school. 

From New York City, you drive west to visit the Midwest.

I would like to float down the Mississippi River and camp at Mount Shasta. 

In the center of New York City is Central Park, flanked by the West Side and the East Side.

Washington State has a great university. 

She is a member of the Third Congressional District.

Correct Format for Geographic Terms (Continued)

We purchased venetian blinds, french fries, and scotch whiskey while visiting the South of France. 

Chicago often is referred to as the Windy City. 

Let’s check out The Street (Wall Street) while in New York. 

I would like to eat Chinese food while visiting the Congo. 

I have a pen pal in St. Louis, Missouri. 

We visited the lakes Huron and Michigan. 

Traffic is crazy in Greater Los Angeles. 

Chicago has a South Side and London has Bloomsbury. 
[bookmark: _Toc415144342]Notes

United States often is abbreviated, especially when used as an adjective (e.g., U.S. military action). Countries whose abbreviations are formed by the initial letters of the constituent words may be unpunctuated (e.g., USA).

Generally abbreviate Saint when part of a geographic name. 

When in doubt about whether to capitalize geographic terminology, consult a dictionary. 

[bookmark: _Toc396974477][bookmark: _Toc415144343]Lists (Bulleted and Numbered)

[bookmark: _Toc415144344]General Guidelines 

Lists often are used to organize information within text. Several things affect the capitalization and punctuation of vertical (bulleted, numbered, and unnumbered) lists, including how they are introduced, whether they are sentences or parts of sentences, item length, and stylistic consistency. Consistency is the most important consideration within the document and on the same page for similar types of lists.

First 5 California’s standard bullet is the closed circle for first level and the open circle for second level lists. Align numbers and first level bullets with the left margin of text. 


Basic guidelines for creating lists include the following:

· Capitalize the first word. 

· Introduce each bulleted or numbered list with a colon. 

· Leave a space between the introductory colon and the first line item. 

· Use double spacing for all line items. 

· Use a period at the end of sentences. 

· If one item needs a period, use periods for all items. 

· Omit closing punctuation if each listed item is an incomplete sentence. 

· Use parallel style (e.g., do not mix list items that begin with verbs with list items that begin with nouns). 

· Use a numbered list for procedures, steps, or other items that must appear in a specific sequence. 
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[bookmark: _Toc415144345]Parallel Structure

Keep the elements in a vertical list parallel. If you included the verb as part of the introductory statement, do not include another verb(s) as part of the listed elements. 

All items in a list should be alike in syntax (e.g., all should be noun forms, phrases, or full sentences where possible). 

[bookmark: _Toc415144346]Examples
Parallel Structure for Lists

The CSU, through its expenditures and the enhanced earnings of its graduates in the workforce, impacts California’s economy in several major ways:

· Generating a $70 billion total annual spending impact in the state

· Supporting more than 485,000 jobs in California 

· Creating $4.9 billion in tax revenue for state and local governments

The First 5 California campaign encourages parents to:

· Talk

· Read

· Sing
[bookmark: _Toc415144347]Punctuation

Introduce each list with a colon. Lists should not have closing punctuation unless the items are complete sentences. Do not leave some items punctuated (e.g., independent clauses and complete sentences) and others not punctuated (e.g., dependent clauses and/or short phrases). If one item in the list is a complete sentence, then each entry must have a period. If necessary, rewrite listed items to maintain consistency. 


[bookmark: _Toc415144348]Examples
Correct List Punctuation

Following are the items you need to bring to orientation:

· Pencil

· Notebook

· Photo identification

Our Parent Signature Program consists of: 

· An award-winning Kit for New Parents designed to provide information and tips for parents, grandparents, and caregivers

· A Hands-on Health Express traveling exhibit van that features “Edutainers” that empower families to incorporate fresh fruits and vegetables into their everyday lives with interactive games, activities, and play market

· The Parent Education Site at http//www.first5california.com/parents to support parents, grandparents, and caregivers

[image: https://fbcdn-sphotos-f-a.akamaihd.net/hphotos-ak-xap1/v/t1.0-9/1918466_1111347229232_3213815_n.jpg?oh=3f66d159806d328ea445378f71a3d0d1&oe=55109C38&__gda__=1423582503_f255680c8d64f47e8eaa5b02af44e159]

[bookmark: _Toc415144349]Spacing 

The First 5 California standard is to double-space all list items. 

[bookmark: _Toc415144350]Numbered Lists

It is not necessary to number items in a list unless the order of the elements must be maintained (as in a set of instructions or procedures), or if the element is referred to by letter or number elsewhere in the text. If enumerating in a vertical list, use a period without parentheses after the number or letter. However, if enumerating in text rather than with a list, follow the numeral with an end parenthesis without a period. 
[bookmark: _Toc415144351]Examples
Correctly Formatted Numbered Lists

The qualifying application packages include: 

1. A two-page essay on the importance of being earnest

2. A 10-page essay on the virtues of coffee, chocolate, and red wine

3. A check or money order for $500

The lecturer will discuss 1) energy; 2) mass; 3) the speed of light; and 4) the amount of energy released during a hydrogen-bomb explosion.
[bookmark: _Toc396974478][bookmark: _Toc415144352]Numbers

[bookmark: _Toc415144353]General Guidelines

In general, spell out only single-digit numbers and use numerals for figures 10 and greater. The exception is when you have a series of numbers, some below 10, some 10 or above, in which case use numerals throughout. 

Begin sentences with spelled out numbers, not numerals. 

Use words, not numerals, for ordinal numbers. An ordinal number expresses degree, quality, or relative position in a series as first, second, or third. Use a hyphen with an ordinal with two parts (twenty-third).

Do not use an apostrophe to form the plural of a numeral. 

Use hyphens or periods to separate numerals in phone and fax numbers 
Use numerals with section, chapter, page, and line numbers, and other coordinates. 
In general, use commas in numbers that have four or more digits, except for years and page numbers. 

If you designate ranges, repeat the numeric range label in the sentence. 
[bookmark: _Toc415144354]Examples
Correct Number Formats

The child counted to five before losing her place. 

The children started the game with 15 water balloons among them. 

The students were 8, 10, and 12 years old. 

Nine hundred people gathered for the event. 

The fourth edition of the manual was released in the twenty-third century.

Zachary is a fifth-grader.

Temperatures were in the 80s and 90s. 

Her phone number is 1-800-555-1212 OR 1.800.555.1212.

See page 9, section 3, chapter 12, and line 5. 

The year was 1996, nine years after 1987. 

They estimate between $7 million to $12 million in damages. 

The increase in income is expected to fall between 3 percent and 10 percent. 




[bookmark: _Toc415144355]Dates and Times

Avoid line breaks in dates and with numbers in general. 

When specifying a range of years, use full years. 

Spell out weekdays and names of the months. 

Do not use st, th, nd, or rd after a number, unless using only the numbers. 
When a phrase includes only the month and year, do not separate the year with a comma. 

When a phrase includes a month, day, and year, insert a comma before and after the year. 

Use numerals to emphasize exact times. 

To denote a fiscal year, type the four-digit fiscal year followed by an en dash and then the subsequent two-digit year. To insert an en dash, type the first word or number then a space followed by a hyphen, another space, and the next number or word. 
[bookmark: _Toc415144356]Examples
Correctly Formatted Dates and Times

The grant was designated for 2006 and 2007. 

Return the form between June 30, 2014, and December 31, 2014.

The event was scheduled for Tuesday, September 09, 2014.

The meeting was held in May 1993.

Christmas falls on December 25 every year. 

We will meet on the 5th of every month. 

The meeting is scheduled for 9:30 a.m. 

The itemized budget was for Fiscal Year 2013–14.


[bookmark: _Toc415144357]Measurements and Money

Use numerals for measurements, including distance, volume, and size, even if the number is less than 10. This rule does not apply to units of time (e.g., days, months, or years). 

When referring to whole sums of money, do not use a decimal point with accompanying zeros unless the sums appear in the same context with fractional amounts. 

For sums of money a million dollars or greater, use the $ and spell the numeric designation. 

[bookmark: _Toc415144358]Examples
Correctly Formatted Measurements and Money

The floor is 15 feet long and 9 feet wide.  

She paid $500 for the plane ticket and $5 for a magazine. 

Lon paid $1.35, Jim paid $1.25, and Eileen paid $1.00 for apples. 

The property now is worth $4 million. 
[image: P:\Communications\Shared Folder\photos\110113_Employee Children Photos for Jamie Hastings\Lisa Duerrs daughter at 15 months.jpg]

[bookmark: _Toc415144359]Ordinals and Percent vs. %

Do not use ordinals with dates. An ordinal number expresses the degree, quality, or position in a series (e.g., first, second, and third). 

Use numerals to express percentages unless a sentence begins with a percentage. 

In running text, use the word percent, not the symbol (e.g., %) with numbers. Running text is the body of the text and is different from headings, footnotes, etc. 
[bookmark: _Toc415144360]Examples
Correct Dates and use of Percent Versus %

The last day of school is June 13. 

She correctly answered 75 percent of the questions. 

Forty-seven percent of the passengers on the plane were female. 
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[bookmark: _Toc415144361]Tables, Figures, and Fractions 

In tables, charts, and illustrations, use the % symbol instead of spelling out percent. 

To represent whole numbers with fractions, use numerals.

If you spell out numbers at the beginning of a sentence, hyphenate words that end in ty.  
Add a zero before the decimal point if the amount is less than one. 

For figures less than one (e.g., fractions [one-fourth]), spell out amounts and use hyphens. 

[bookmark: _Toc415144362]Examples
Examples of Correct Figures and Fractions

We need ½ cup of sugar for every 2 cups of flour. 

Thirty-one people attended the party. 

One hundred twenty-nine years ago, there was a terrible drought. 

The factor is increased by 0.033 for every quarter year.

[bookmark: _Toc396974479]The answer is one-half, two-thirds, or two-tenths of 1 percent. 
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[bookmark: _Toc415144363]Prepositions

Prepositions show relationships in space and time and must be accompanied by an object. Make your writing more direct, concise, and easy-to-understand, by reducing prepositions and prepositional phrases. Ensure subject-verb agreement and do not end a sentence with a preposition unless your ear tells you otherwise.

[bookmark: _Toc415144364]Examples
Concise Sentences – no Prepositional Phrases

First 5 California promotes Early Childhood Education. 

California’s children receive the best possible start and thrive.  

She responded enthusiastically. 

First 5 California proactively engages parents. 
[bookmark: _Toc396974481]
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[bookmark: _Toc415144365]Proofreading Symbols

Use these symbols when editing and proofreading documents to ensure accuracy, consistency, and adherence to the prescribed guidelines. [image: ]
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[bookmark: _Toc396974480][bookmark: _Toc396974482]

[bookmark: _Toc415144366]Proofreading

This section provides proofreading tips to assist writers in performing quality assurance on their own written work. Writing is a reflection of the author. If a document has grammatical errors and typos, people are not likely to take the author or the content seriously. 

[bookmark: _Toc415144367]Why Proofread? 

Even if proofreading doesn't seem necessary, it is important to keep in mind that while what you wrote made sense in your head, it may not have translated well into writing. Further, you may not have typed it correctly. Proofreading is a required step to ensure your work is polished, and represents you and the organization in a professional manner. 

Thorough proofreading is a critical component of maintaining an organization’s credibility and reputation. Following are some proofreading tips. These tips are not documented in order of importance and should be used collectively to ensure the best possible product. 

[bookmark: _Toc415144368]General Guidelines (How to Proofread)

Always use a spell checker, and remember that even if spell checker does not identify a misspelled word, your document may not be error-free. If you spelled the word correctly but misused it, spell checker may not have noticed (e.g., use of a homophone, such as "there" when you meant "they're"). 

Step away from the text when you finish typing something. Take some time away from the document before you proofread it. When the material is fresh in your head, sometimes it is difficult to notice typos and grammatical errors. Going back over the document with a clear head will help you see it with fresh eyes. 

When proofreading a document, first read it slowly and carefully to determine whether or not it communicates your intended message and content. Read the entire document before you begin to mark it. 

Verify the introductory paragraph clearly signals the intent of the document and that the paragraphs that follow flow naturally from the introduction. If this is not the case, consider re-writing those components, as necessary. 

Check for content accuracy and completeness, and make sure you have included all necessary visuals, tables, and charts. 


Verify data (e.g., calculations, spreadsheet figures). This generally is more effective with two people doing the proofing. One can read numbers while the other checks the hardcopy. 

For text documents, have another person proofread your draft. This will give you an accurate idea of how your reading audience will read and perceive your work. Have proofreaders initial the copy they review. 

Reading hard copy (paper) is easier on the eyes than reading text on a computer screen, so proofread, and mark a hard copy, if possible/necessary. 

In addition to the general tips listed in this section, work through the following checklist before submitting your document for formal review: 

[bookmark: _Toc415144369]Proofreading Checklist

· Make sure text adheres to the First 5 California Writing Standards Style Guide.

· Verify all URLs, phone numbers, addresses, and statistics.

· Check the table of contents to make sure it matches chapter or section titles.

· Review headers for understanding and consistency.

· Review the flow of information and sequence to ensure logical flow and accuracy. 

· Get permission and give proper credit for photos and reprinted material.

· Ask someone to do a “fresh eyes” review, preferably someone who has not seen the copy before.

· Look for:

· Redundancies

· Complex sentences

· Incomplete sentences

· Inappropriate or misused language

· Subject-verb agreement

· Misplaced modifiers

· Missing, extra, or transposed letters or numbers

· Mixed person or voice

· Wrong pronoun (“they” used to refer to “an individual”)

· Spelling errors

· Missing or incorrect punctuation

· Capitalization errors

· Extra or missing spaces

· Inconsistent verb tense

· Incorrect homophones (they’re/their/there)

· Apply these general techniques, as appropriate: 

· Read text backwards.

· Hold the paper sideways to help identify odd spacing.

· Move a ruler or piece of paper down the lines of type as you read.

· Read out loud to another person and give the person a copy to follow.

· Segment your proofing (e.g., look at one issue at a time).

· Make your editing marks legible and understandable.

· Use the prescribed proofreading symbols.

· Read pages out of order.

[bookmark: _Toc415144370]Punctuation

Punctuation is critical to ensure accurate articulation and clarity in reading and writing. First 5 California’s standard is a single space after punctuation. 

[bookmark: _Toc415144371]Colons

A colon is used to explain or start an enumeration. Use a colon at the end of a sentence to introduce lists or tabulations. Capitalize the first word after the colon if what follows is a complete sentence.
[bookmark: _Toc415144372]
Examples
Correctly Used Colons

We based our decision on three things: expense, time, and value.

We promise this: We always will treat you with courtesy, respect, and kindness.
[bookmark: _Toc415144373]Commas

A comma is a punctuation mark used to indicate a separation of ideas or of elements within the structure of a sentence. First 5 California adopts the Oxford, or series comma, as our standard. An Oxford comma is a comma placed immediately before the coordinating conjunction (usually and, or, or nor) in a series of three or more terms. Insert a comma before the final item in a series. 

Set off nonessential clauses with commas. Nonessential means the sentence makes sense without the clause. 

Use a comma to separate an introductory phrase from the main clause.

Use a comma if the subject of each clause is stated. A comma is not required if the clauses share the same subject.

Use a comma to separate a series of adjectives if the adjectives are equal in rank and the commas could be replaced with and.

Do not use a comma when the adjective before the noun is integral to the noun phrase.
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[bookmark: _Toc415144374]Examples
Correctly Used Commas

My favorite foods are spaghetti, salmon, and chicken salad. 

You may choose to attend some, rather than all, of the seminar sessions. 

When they learned all about the Civil War, they began to study 
World War I. 

During the meeting, her thoughts drifted to the weekend.

We visited the Capitol Building, and our representative greeted us on the front steps. 

We are visiting the Capitol and plan to see the rose garden.

She proceeded in a thoughtful, deliberate manner.

They appreciated the convenient direct deposit option. 
[bookmark: _Toc415144375]Contractions

A contraction is a shortened version of the written and spoken forms of a word or words created by omission of internal letters. Contractions may be used to establish an informal or friendly tone. That said, First 5 California writing generally is more formal and use of contractions should be minimal. 

[bookmark: _Toc415144376]Examples
Correctly Used Contractions

You’re (you are)					It’s (it is) 
Won’t (will not)					Doesn’t (does not)


[bookmark: _Toc415144377]Ellipsis 

An ellipsis is constructed of three spaced periods with a space on either side. Use an ellipsis to indicate the omission of a word or words. 
[bookmark: _Toc415144378]Examples
Correctly Used Ellipses

The governor was quoted as saying “… this program will benefit many.” 

Camille ended her speech stating “… and it has been a pleasure to meet with you today.” 
[bookmark: _Toc415144379]Em Dash

Em dashes are so named as they are the width of the character m. They are used for emphasis or interruption and can be used on their own or in pairs to offset a word or phrase. Most word-processing programs automatically convert double hyphens into em dashes. To enter an em dash, type a word or letter and then two hyphens and another space and the two hyphens will convert to an em dash. 
[bookmark: _Toc415144380]Examples
Correctly Used Em Dashes

Many parents rely on First 5 California for educational materials—the Kit for New Parents, videos, and Hands-On Health Express—to improve early childhood education. 

A vast amount of serotonin—about 95 percent of the body's total—is produced in the digestive system.
[bookmark: _Toc415144381]En dash 

En dashes are the width of the character n and may be used to connect two items that designate a range. They replace hyphens when one part of an open compound is made up of two words. En dashes also may be used to indicate tension or opposition exists in a relationship, or to show a direction of movement. To use an en dash, place the cursor after the first word, add a space, type two hyphens, another space, and the next word. Add a space after the second word and the two hyphens will convert to an en dash. Only when referring to a fiscal year, delete the spaces on both sides of the en dash. 
[bookmark: _Toc415144382]Examples
Correctly Used En Dashes

We submitted chapters 10 – 12 well after midnight.

I left at halftime with the score stuck at 3 – 1. 

The January – February issue is due on newsstands tomorrow. 

She was responsible for drafting the Fiscal Year 2014–15 report.

The New York – Washington, D.C. run takes about three hours by train.
[bookmark: _Toc415144383]Hyphen

The hyphen is a punctuation mark used to join words and to separate syllables of a single word. The hyphen should not be confused with dashes, which are longer and have different uses, or with the minus sign, which also is longer.

Never use a hyphen when using an adverb that ends in ly.

Many combinations that are hyphenated before the noun they modify are not hyphenated when they follow the noun. 

Use a hyphen with spelled-out fractions. 

Hyphenate both words in a hyphenated word when used in a title.
[bookmark: _Toc415144384]Examples
Correctly Used Hyphens

He recovered the data. He re-covered the chair.

Studies conclude high-quality preschool programs improve school readiness.

The doctor prescribed an anti-inflammatory medication for the swelling. 

We finally are experiencing fall-like weather.
Correctly Used Hyphens (Continued)

The pre-election results are available.

Twenty-one people attended the CARES Plus training event. 

She received her lump-sum payment for publicly traded stock. 

 He is a well-liked individual. 

She works in an environmentally friendly building.

Jane covered one-third of the page with contact paper. 

She read his article titled Evidence-Based Practice.
[bookmark: _Toc415144385]Parentheses 

Parentheses are used to enclose information that clarifies or is used as an aside. 

When you use parentheses, place the period outside a closing parenthesis if the material inside is not a complete sentence. If the material is a complete sentence, place the period inside the closing parenthesis. Additionally, always use parenthesis when using e.g., or i.e., within a sentence. 
[bookmark: _Toc415144386]Examples
Correctly Used Parentheses

John went to the corner market (after having visited the farmers’ market) and finally found fresh corn. 

Jane preferred to shop at her local grocery story. (Jane’s mother preferred the farmers’ market.) 

We recommend using an easy-to-read font (e.g., Arial). 

Our backup drives (i.e., drives F and G) are new.



[bookmark: _Toc415144387]Quotation Marks

In English writing, quotation marks are punctuation marks placed on either side of a word or phrase to identify the word or phrase as a quotation, direct speech, or a literal title or name.

When it comes to commas and periods, the Universal American usage places commas and periods inside the quotation marks. Use single quotation marks for quotations within quotations.

When you use a question mark or exclamation point with a sentence that ends in a quotation, if the punctuation is part of the quotation itself, put it inside the quotation marks. If the punctuation governs the sentence as a whole but not the material being quoted, put it outside the quotation marks.
[bookmark: _Toc415144388]Examples
Correctly Used Quotation Marks

"Jane," she said, "put the book down and go outside for a little while." 
"I will in a minute," she replied, "as soon as I finish this chapter."

Have you read the assigned short story, "Flowering Judas"? No, but I did finally get around to reading last week's assignment, "Where Are They Now?" 

He said, "Dan cried, 'Do not treat me that way.' "
[bookmark: _Toc415144389]Semicolon

The semicolon stands in for missing conjunctions (and, but). Use semicolons to link independent clauses. 

Use to separate elements in a series when the items in the series are long or the segments contain items that also must be set off by commas. Consider breaking longer independent clauses into separate sentences or organizing them into a bulleted list. 




[bookmark: _Toc415144390]Examples
Correctly Used Semicolons

They promised to deliver the package today; it arrived this afternoon. 

I certify under penalty of perjury that I am not legally married or registered as a domestic partner; I have never married or registered as a domestic partner; I am divorced, widowed, or have terminated or dissolved my domestic partnership; or my spouse or partner has died.
[bookmark: _Toc415144391]Slashes

The slash is most commonly used as the word substitute for or, which indicates a choice (often mutually-exclusive) is present. Another use of the slash is to replace the hyphen or en dash to make a clear, strong joint between words or phrases. 

Avoid using and/or. Also avoid using a slash between other words as the intent is unclear to mean and or or. Use slashes in URLs, as appropriate. 

[bookmark: _Toc415144392]Examples
Correctly Used Slashes

He/she qualified for the grant. 

She preferred works from the Hemingway/Faulkner generation. 

Please circle Y/N to indicate your responses to the survey questions. 

Go to www.First5California.com/parents for more information. 
[bookmark: _Toc415144393]Spacing

Use only one space following periods, commas, semicolons, colons, exclamation points, question marks, and quotation marks. 


[bookmark: _Toc415144394]Examples 
Punctuation Spacing

There are three sentences in this paragraph. There is only one space after the period. Be sure to consistently use only one space after punctuation throughout your documentation. 
[bookmark: _Toc415144395][bookmark: _Toc396974483]Tables 

The purpose of tables is to organize data and information so it is easier to understand. Often, a visual representation is easier to process than a narrative. 

[bookmark: _Toc415144396]General Guidelines

A table must be at least two columns and two rows. Typically, the first column contains information that relates to information in the second column. 

When creating a table, use the following guidelines: 

· Capitalize only the first word in a column heading. 

· Capitalize the first word of each table entry.

· Follow punctuation guidelines for Lists described earlier in this document.

· Clearly label the table with a title, and, if applicable, a number.

· Ensure all entries are parallel in structure (e.g., begin each entry with a verb).

· Use standard font (Arial 12).

· Strive to keep related material together on one page.

· Avoid orphans (first line of a sentence or paragraph that prints at the bottom of a page with the rest of the paragraph appearing on the next page).

· Avoid widows (the last line of a paragraph that prints at the top of a page or one or two words that appear on a separate line in a paragraph).


Word has an automatic setting that prevents widows and orphans. To set this feature:

1. Open the Format menu and select Paragraph.

2. On the Line and Page Breaks tab, check Widow/Orphan Control. 

3. From this tab, you also can choose to keep lines of a paragraph together on a page or in a column (Keep Lines Together box).

[bookmark: _Toc415144397]Examples 
Sample Table

[image: http://www.technicalforum.org/sites/default/files/Sample-Table-Format.png]
[bookmark: _Toc396974484][bookmark: _Toc415144398]Templates

Templates are located on the Intranet under the Employee Resources tab. First 5 California recommends using a new template from the Intranet when you begin a document. This will ensure you are using the most current version. 

[bookmark: _Toc396974485][bookmark: _Toc415144399]Tone

Tone creates the relationship between the writer and reader. To engage your specific audience, strive to make writing professional and friendly. Connecting with the reader is essential. Use a consistent tone, know your audience, focus on the reader’s viewpoint, and project what will benefit that audience. 


Assess whether the tone is too formal, overly authoritative, condescending, or distant. Will the tone win the reader’s trust and convey what the audience needs and wants to know. Your writing represents First 5 California and should adopt a consistent tone that conveys professionalism.

You can achieve a professional tone by directly addressing the reader and using clear and concise language and terminology. 
To analyze the tone, read and reread your work with fresh eyes. Set your work aside after completing the first draft and revisit looking closely for anything that is inaccurate or might convey bias, stereotyping, or insensitivity.

All readers expect to be able to understand text the first time they read it. If you, the writer or editor, must reread text to understand it, then it probably needs to be rewritten to ensure clarity and eliminate redundancy. 

[bookmark: _Toc415144400]General Guidelines 

Try not to use jargon or bureaucratic language. Avoid turning a verb or adjective into a noun with endings such as -tion, -able, -tive, -ness, and -ance. Do not say it is our recommendation that to mean we recommend.

Use simple verb tenses (e.g., we received, not we have received) and declarative sentences (subject-verb-object). Jerry wrote the report, not Jerry, whose mother was a teacher in the 1950s, wrote the report. 

Vary sentence length to help move the reader’s eye along and cover only one topic in each paragraph. Keep paragraphs short.

[image: C:\Users\Infinitiy\Downloads\Jaime Hastings son.jpg]

[bookmark: _Toc415144401]Words to Avoid and Recommended Alternatives

Avoid words and images that might convey stereotypes, prejudice, or gender bias to any potential reader. Be sure text, photos, and examples reflect diversity. Use a variety of names that represent male, female, and different cultural backgrounds. Use gender-neutral or inclusive words instead of masculine terms. 

[bookmark: _Toc415144402]Examples 
Appropriate Word Choices and Words They Replace

Chair (Chairman, Chairwoman)		Spouse (Husband, Wife) 
Work force/staff (Manpower) 		Ancestors (Forefathers) 
Seniors (Elderly) 				Executive (Businessman)
Person (He/She) 				Courier (Delivery Boy/Girl)
Worker (Workman) 				Graduates (Alumni) 
[bookmark: _Toc415144403]Trademark and Registered and Service Mark Guidelines

[bookmark: _Toc415144404]Definitions

A registered mark or registered trademark symbol designated by ® (the circled capital letter R) is a symbol that provides notice that the preceding word or symbol is a trademark or service mark that has been registered with a national trademark office. In some countries, it is against the law to use the registered trademark symbol for a mark that is not officially registered in any country.

A service mark is a trademark used in the United States and several other countries to identify a service rather than a product. When a service mark is federally registered, the standard registration symbol ® or "Reg U.S. Pat & TM Off" may be used (the same symbol is used to mark registered trademarks).

A trademark is a recognizable sign, design, or expression that identifies products or services of a particular source from those of others. The trademark owner can be an individual, business organization, or any legal entity. A trademark may be located on a package, label, voucher, or on the product itself.

On the following page are the Teachstone Trademark Guidelines. First 5 California adheres to the following Teachstone Trademark Guidelines for professional writing that includes Teachstone’s proprietary items. 


[bookmark: _Toc415144405]Examples 
[image: ]

[bookmark: _Toc396974486][bookmark: _Toc415144406]Word Usage

This Section includes First 5 California preferred word usage. The key word is in bold, shown as it should appear in text. Some key words include text that explains usage. Other entries simply show the correct spelling, hyphenation, or capitalization.


[bookmark: _Toc415144407]A


[bookmark: _Toc415144408]a, an

Use a before a consonant sound and an before a vowel sound. 

[bookmark: _Toc415144409]about, around

Use about for approximately. Use around for location. 

We had about 60 attendees. 

I thought that street was around here.

[bookmark: _Toc415144410]accept, except

Accept means to receive. 

I accept your apology. 

Except means to exclude. 

She purchased everything except oranges.

[bookmark: _Toc415144411]access

This word is best used as a noun, not a verb. 

We have access to many resources. 

However, in the context of information technology, it is common to use access as a verb. 

You can access the website 24 hours a day. 


[bookmark: _Toc415144412]acknowledgment

There are only two es in this word. There is no e after the dg. It is not spelled acknowledgement. 

[bookmark: _Toc415144413]affect 

Affect as a verb means to influence. 

How do you think that will affect us?

[bookmark: _Toc415144414]afterward

There is no s at the end of this word (NOT afterwards).

[bookmark: _Toc415144415]aid, aide

Aid means assistance. 

He came to her aid when she was attacked by the dog. 

An Aide is an assistant. 

The nurse’s aide worked in the office three days a week. 

[bookmark: _Toc415144416]allude, elude, refer 

Allude means to speak (or write) of something without specifically mentioning it.

The State Controller did allude to the possibility of delayed payment in his speech. 

Elude means to avoid or evade. 

With quick maneuvering, he was able to elude the lunging lion. 

Refer means to mention or reference something directly. 

She often referred to her experience in her previous job. 


[bookmark: _Toc415144417]allusion, illusion

Allusion is an indirect reference. 

The allusion was to her opponent’s alleged criminal record.

Illusion means an unreal or false impression. 

The magician created the illusion of walking on air. 

[bookmark: _Toc415144418]among, between

Use among for collective relationships (more than two people) and relationships of three or more items.

There is honor among thieves. 

The work was divided among Sue, Carl, and James. 

Between typically is used for one-to-one relationships. 

Between you and me, I preferred the second training session. 

[bookmark: _Toc415144419]ampersand (&)

Only use the ampersand when it is part of a company’s formal name (e.g., Arm & Hammer); otherwise, use and instead of the ampersand symbol. 

[bookmark: _Toc415144420]anticipate, expect

Anticipate means to foresee and deal with in advance. 

They anticipated the arrival of additional guests by cooking more food. 

Expect does not include the notion of preparation. 

They expected the visitors to arrive by noon. 


[bookmark: _Toc415144421]assure, ensure, insure 

Assure means to set the mind at rest. 

The mutual fund manager assured her clients that their assets were safe. 

Ensure means to guarantee. 

To ensure data accuracy, several researchers validated the calculations. 

Insure refers to insurance. 

The policy insures his vehicle. 

[bookmark: _Toc415144422]at risk, at-risk

Use at risk with of not for. 

The child is at risk of developmental delay. 

At-risk is a modifier. 

She is an at-risk student. 

[bookmark: _Toc415144423]average

The average is the result obtained by dividing a sum by the number of quantities added together. 

The average of 7, 9, and 17 is 11 (e.g., 33 divided by 3). 


[bookmark: _Toc415144424]B


[bookmark: _Toc415144425]bad, badly

Bad generally is used as an adjective. 

They had a bad phone connection. 

Badly is an adverb used to describe a verb. 

They wanted to win badly. 

The miner was hurt badly. 

[bookmark: _Toc415144426]benefit

The noun form of benefit is an advantage or profit gained from something. 

They purchased the house with the benefit of a large discount. 

The verb form of benefit is to receive advantage, profit, or gain. 

The children would benefit from additional exercise. 

[bookmark: _Toc415144427]beside, besides

Beside is defined as at the side of something or someone. 

Jack sat beside Jill on the hill. 

Besides is defined as in addition to something. 

Besides, Bill wanted to replace all the light fixtures in the house. 

[bookmark: _Toc415144428]between, among

Between typically is used for one-to-one relationships. 

Between you and me, I preferred the second training session. 

Use among for collective relationships (more than two people) and relationships of three or more items.

There is honor among thieves. 

The work was divided among Sue, Carl, and James. 


[bookmark: _Toc415144429]bi, semi

Bi usually means two. 

Biweekly meetings occur every two weeks. 

Semi usually means half. 

Semiweekly meetings occur twice a week. 

These prefixes often are misunderstood. Define them at the first usage.

[bookmark: _Toc415144430]biannual, biennial

Biannual means twice yearly and is synonymous with semiannual. 

We conduct our biannual conferences in January and June. 

Biennial means every other year.

We host the family holiday celebration biennially, on even years. 

These words often are misunderstood, so define them at the first usage.

[bookmark: _Toc415144431]birthdate, birth date

Use date of birth. Do not insert hyphens. 

She entered her date of birth on the application. 

[bookmark: _Toc415144432]both, and

Both parts of this construction must be grammatically parallel. The rule applies for other pairings as well, including not only….but also; either…or; and neither…nor. 

He was both loyal to his friends and forgiving to his enemies. 

This is parallel because both loyal and forgiving are adjectives. 

[bookmark: _Toc415144433]breastfeed 

Breastfeed is one word and does not include a hyphen. 


[bookmark: _Toc415144434]broadcast

Broadcast is the appropriate spelling for both the present and past tenses of this word. Broadcasted is NOT a word. 

[bookmark: _Toc415144435]by-product 

A by-product is something usually produced in an industrial or biological process in addition to the principal product or outcome. 

Animals often are fed meat by-products that are deemed unfit for human consumption. 


[bookmark: _Toc415144436]C


[bookmark: _Toc415144437]can, may, might

Can indicates the ability or power to do something.

She can climb to the top of the ladder. 

He can run a half marathon.

May indicates permission or possibility.

You may leave whenever you wish. 

She may be able to start work tomorrow. 

Might indicates probability, possibility, and permission. 

She might pass the class. 

[bookmark: _Toc415144438]cancel, canceled, canceling, cancellation

The above spellings are the correct spellings for these words. 


[bookmark: _Toc415144439]capital, capitol

Cities that serve as seats of government are capitals. Capital also means money or wealth. 

Sacramento is California’s capital city. 

He invested capital in the new business. 

A capitol is almost always a building.

Congress meets in the Capitol. 

[bookmark: _Toc415144440]caregiver, caregiving

A caregiver is a person who looks after a child, or elderly, ill, or disabled person. 

She was the primary caregiver for her mother. 

Caregiving is the act of providing care to another. 

That person is employed in the caregiving industry. 

Note the correct spelling above. These are NOT hyphenated words. 

[bookmark: _Toc415144441]carry over, carryover

The term carry over is a verb. 

We can carry over that item to the next fiscal year. 

The term carryover is a noun. 

This debt is a carryover from the last fiscal year. 

[bookmark: _Toc415144442]chair

Use chair instead of chairman or chairwoman to avoid gender bias. 


[bookmark: _Toc415144443]checklist 

A checklist is a type of informational job aid used to reduce failure by compensating for potential limits of human memory and attention. It helps to ensure consistency and completeness in carrying out a task. 

Checklist is one word and does not include a hyphen. 

He reviewed each item on his proofreading checklist before sharing the document with his colleagues.  

[bookmark: _Toc415144444]check up, check on, checkup

Do not use the term check up. Instead, use the term check on as the verb form of checking, inspecting, or scrutinizing someone or something. 

The mother went into the nursery to check on her baby. 

The noun checkup is defined as a physical, medical, or clinical examination.

The father took his son to the doctor for his annual pediatric checkup. 

[bookmark: _Toc415144445]child care 

This is not one word. Child care is two words without a hyphen. 

[bookmark: _Toc415144446]child care center 

Use child care center instead of day care center. The care is provided to the child, not the day. 

[bookmark: _Toc415144447]children with special needs (and disabilities) 

Do not use the term special needs children. The appropriate language is children with special needs (and disabilities). 

The Center for Children with Special Needs provides information to families and professionals focusing on children who have chronic physical, developmental, behavioral, or emotional conditions. 

[bookmark: _Toc415144448]commit, committed, committing, commitment

The above spellings are the correct spellings for these words. 


[bookmark: _Toc415144449]common sense, commonsense

Common sense is a noun and is two words. 

Common sense will see us through. 

Commonsense is an adjective used to describe a noun. 

Commonsense rules are in place.

[bookmark: _Toc415144450]compare to, compare with 

Compare to puts two things in the same category or shows how they are alike. 

She compared my writing to Steinbeck’s. (She said my writing is like Steinbeck’s.) 

The term compare with is more common and is used to consider both similarities and differences.

She compared my writing with Steinbeck’s. (She called out like and unlike traits in our writing.)

[bookmark: _Toc415144451]compatible

Compatible is defined as able to exist or occur without conflict. 

The fruitiness of Beaujolais is compatible with a number of meat dishes. Note the correct spelling. 

[bookmark: _Toc415144452]complement, compliment 

Complement is a noun or verb denoting completeness or the process of supplementing something. 

Her skills and talent were the perfect complement to our leadership team. 

A compliment is a noun denoting praise or the expression of courtesy.

The manager complimented her staff for a job well done. 


[bookmark: _Toc415144453]comprise

Comprise means to contain. Therefore, comprised of is incorrect. The writer or speaker may mean consists of or composed of. The whole comprises the parts and NOT the other way around. 

Our Parent Signature Program comprises: 

· The Kit for New Parents 

· Hands-on Health Express

· The Parent site

[bookmark: _Toc415144454]consensus

Consensus means general agreement. Terms such as general consensus are redundant. Avoid them. 

The consensus was to amend the bill. 

[bookmark: _Toc415144455]continual, continuous

Continual means recurring at frequent intervals. 

Snow fell continually during our Tahoe vacation. 

Continuous is defined as going on without interruption. 

The students respond well to constant encouragement and continuous feedback. 

[bookmark: _Toc415144456]cost effective, cost-effectiveness

Cost effective means economical in terms of tangible benefits produced by money spent. 

It was cost effective to purchase the high efficiency washing machine. 

Cost-effectiveness is the relationship between the monetary inputs and the desired outcome. 

The marketing campaign increased sales revenue, highlighting the campaign’s cost-effectiveness. 


[bookmark: _Toc415144457]coursework

Coursework is work performed by students or trainees for the purpose of learning. 

She has four more units of coursework to complete for her degree. 

[bookmark: _Toc415144458]credentialed, credentialing

Credentialed means having the qualifications to show you are trained or suitable for a specific job. 

She was a credentialed educator. 

Credentialing is the process of verifying the qualifications and backgrounds of professionals or organizations. 

He submitted his application to the credentialing agency for validation. 

[bookmark: _Toc415144459]crisis, crises

Crisis is singular. 

She was in the middle of a financial crisis. 

Crises are more than one crisis (plural). 

The fire chief was managing crises for three counties. 

[bookmark: _Toc415144460]criterion, criteria

Criterion is singular. 

The criterion for passing the exam was achieving a minimum grade of 70 percent. 

Criteria are more than one criterion (plural). 

Finding cases that meet our criteria is difficult. 


[bookmark: _Toc415144461]cross section, cross-section, cross-sectional

A cross section is a surface or shape that is or would be exposed by making a straight cut through something, especially at right angles to an axis. 

The cross section of an octahedron is a square.

Cross-section is a verb and means to make a cross section of something. 

Complex triangular terrain models for contour cross-sectioning are hard to find. 

Cross sectional means of, or pertaining to, a cross section. 

He studied a cross-sectional sample of the specimen. 

[bookmark: _Toc415144462]crosswalk

Crosswalk is a single word NOT two words. 

She shepherded the children across the street in the crosswalk. 

[bookmark: _Toc415144463]current, currently

Current means belonging to the present time; happening or being used or done now. 

Currently is the adverb form of current. 

These words often are unnecessary. 

The government currently owns 740 million acres of land in the United States. 

[bookmark: _Toc415144464]curricula

The word curricula is defined as the aggregate of courses of study given in a school, college, university, etc.

The school is adding additional math to the curricula. 

Curriculums is NOT a word. 


[bookmark: _Toc415144465]cut back, cutback

Cut back is a verb and means to reduce something. 

The government cut back the available funding. 

Cutback is a noun or adjective. 

There were cutbacks in military expenditures. 


[bookmark: _Toc415144466]D


[bookmark: _Toc415144467]data

The word data is plural and means facts and statistics collected together for reference or analysis. 

She began collecting data to analyze for the annual budget report. 

[bookmark: _Toc415144468]database

A database is a collection of data that is organized so that its contents can easily be accessed, managed, and updated. Database is a single word.

She managed the personnel database for her company. 

[bookmark: _Toc415144469]disinterested, uninterested

Disinterested means not influenced by considerations of personal advantage:

A banker is under an obligation to give disinterested advice. 

Uninterested means not interested in or concerned about something or someone. 

I was totally uninterested in science fiction. 

[bookmark: _Toc415144470]doctorate

Doctorate has the implicit meaning of a degree. It is redundant to day doctoral degree. 

She has her doctorate in psychology. 
[bookmark: _Toc415144471]download

Download is to copy (data) from one computer system to another, typically over the Internet. 

It would be wise to download your program to another computer before testing it. 

[bookmark: _Toc415144472]due to 

Adverbially, because is preferable to due to. 

Because of the quarterback’s injury, the team struggled. 


[bookmark: _Toc415144473]E


[bookmark: _Toc415144474]each

Each is every one of two or more of something, considered individually. Each is used with a singular verb. 

Each of the teachers is highly skilled (NOT each of the teachers are). 

[bookmark: _Toc415144475]ensure, insure, assure

Ensure means to guarantee. 

To ensure data accuracy, several researchers validated the calculations. 

Insure refers to insurance. 

The policy insures his vehicle. 

Assure means to set the mind at rest. 

The mutual fund manager assured her clients that their assets were safe. 

[bookmark: _Toc415144476]ex officio

An ex officio member is a member of a body (a board, committee, council, etc.) who is part of it by virtue of holding another office.

The president is the ex officio commander-in-chief of the armed forces. 


[bookmark: _Toc415144477]expect, anticipate 

Expect does not include the notion of preparation. 

They expected the visitors to arrive by noon. 

Anticipate means to foresee and deal with in advance. 

They anticipated the arrival of additional guests by cooking more food. 


[bookmark: _Toc415144478]expel, expelled, expelling

Note the spelling of these words. 

[bookmark: _Toc415144479]explicit, implicit 

Explicit means there is no room for ambiguity or difficulty in interpretation. 

She was explicit about the school’s funding needs. 

Implicit means something can be inferred without being expressed. 

The president’s foreign policy includes the implicit assumption that all people want peace. 


[bookmark: _Toc415144480]F


[bookmark: _Toc415144481]fact

All facts are true. It is impossible to have a false fact. Therefore, actual fact, real fact, and true fact are redundant. 

She only stated the facts in her testimony. 

[bookmark: _Toc415144482]farther, further

Farther refers to physical distance. 

How much farther must we hike before we can rest? 

Further refers to metaphorical distance. 

Further research will give scientists additional insight. 

[bookmark: _Toc415144483]feasible

Feasible means capable of being done. It does NOT mean probable or plausible. 
It is not feasible to build a house in one day. 

[bookmark: _Toc415144484]fewer, less

The word fewer generally is used for individual or countable items. 

We reviewed no fewer than 500 applicants.  

The word less generally is used for quantity or bulk. 

We need to buy less milk. 

[bookmark: _Toc415144485]field test, field-test

A field test is carried out in the environment in which a product or device is to be used.

They were planning a field test of the business continuity procedures. 

Field-test means to test a device or product under various conditions of actual use. 

The field-test validated their emergency equipment worked properly. 

[bookmark: _Toc415144486]fieldwork

Fieldwork is the collection of information outside of a laboratory, library, or workplace setting. 

The doctors relied on the researchers’ fieldwork. 

[bookmark: _Toc415144487]file name

A file name is used to uniquely identify a computer file stored in a file system. 

I cannot remember the file name. 


[bookmark: _Toc415144488]firsthand, first-hand

Firsthand is defined as from the original source or personal experience and is an adjective. 

Thanks to the outdoor navigation course, we had firsthand experience using a compass. 

First-hand is an adverb. 

We had seen first-hand the horrors of living in a war-ravaged country. 

First hand (two words no hyphen) is incorrect. 

[bookmark: _Toc415144489]fiscal, monetary

Fiscal applies to a budget. 

She worked on the fiscal documents.  

Monetary applies to currency. 

He was unwilling to share his monetary situation. 

[bookmark: _Toc415144490]fiscal year

The state fiscal year runs from July 1 to June 30 and the federal fiscal year runs from October 1 to September 30. 

[bookmark: _Toc415144491]flagpole

A flagpole is used for flying a flag. This is one word and is NOT hyphenated. 

The students met at the flagpole in front of the school. 

[bookmark: _Toc415144492]flowchart

A flowchart is a diagram of the sequence of movements or actions of people or things involved in a complex system or activity.

She developed a flowchart for her project. 


[bookmark: _Toc415144493]foldout

A foldout is a folded insert in a publication that is larger in some dimension than the regular pages. 

The National Geographic contained a foldout of the world map. 

[bookmark: _Toc415144494]following, after

Following generally introduces a list.

She asked him to bring the following: 

· Ice cream

· Soda

· Cups

After usually is the appropriate word in normal text. 

He completed his exam after she finished hers. 

[bookmark: _Toc415144495]follow up, follow-up

Follow up is a verb and means to check in on someone or something. 

The mother will follow up on her child’s homework. 

Follow-up is a noun or adjective. 

She has her medical follow-up scheduled for next Tuesday. 

[bookmark: _Toc415144496]full time, full-time

Full time is an adverb. 

She works full time. 

Full-time is an adjective. 

She has a full-time job. 


[bookmark: _Toc415144497]fundraising, fundraiser

Fundraising is the act of soliciting volunteer contributions. Fundraising can be one or two words and does not require a hyphen. 

She was the fundraising coordinator for the school. 

Fundraiser is a person who solicits volunteer contributions or an event organized to generate contributions.

They planned the third annual fundraiser for the school. 

Fund raiser can be one or two words and does not require a hyphen.

[bookmark: _Toc415144498]further, farther

Further refers to metaphorical distance. 

Further research will give scientists additional insight. 

Farther refers to physical distance. 

How much farther must we hike before we can rest? 

[bookmark: _Toc415144499]future

The future is what will happen in the time after the present. Its arrival is considered inevitable due to the existence of time and the laws of physics. Future often is used unnecessarily as in “He refused to share his future plan.” 

We cannot predict the future. 


[bookmark: _Toc415144500]G


[bookmark: _Toc415144501]gift

A gift is a thing given willingly to someone without payment. Therefore, free gift is redundant.

She loved her birthday gift. 


[bookmark: _Toc415144502]gigabyte

A gigabyte is a unit of information equal to one billion. 

Her computer memory exceeded one gigabyte. 

[bookmark: _Toc415144503]good-bye

Good-bye is an expression of good wishes when parting or at the end of a conversation.

She waved and said good-bye when she left school. 

[bookmark: _Toc415144504]good will, good-will

Good will is friendly, helpful, or cooperative feeling, or attitude. In the noun form it does not require a hyphen. 

The song commends good will toward all people. 

In the adjective form, good-will required a hyphen. 

His offer was a good-will gesture. 


[bookmark: _Toc415144505]H


[bookmark: _Toc415144506]health care, health-care

Health care is the maintenance and improvement of physical and mental health, especially through the provision of medical services. 

She finally was able to afford health care. 

Health-care is an adjective and requires a hyphen. 

She belonged to a newly available health-care program. 


[bookmark: _Toc415144507]Hispanic 

Hispanic refers to people of country heritage that speak the Spanish language. This is a proper noun and must be capitalized. 

They began a new education campaign targeting the Hispanic community. 

[bookmark: _Toc415144508]homepage 

The homepage is the introductory page of a website, typically serving as a table of contents for the site.

She looked for the California First 5 homepage. 


[bookmark: _Toc415144509]I


[bookmark: _Toc415144510]impact 

Impact means to press together or strike forcefully. It often is misused when affect would be appropriate. 

The meteor impacted the earth.

The pollution affected his asthma. 

[bookmark: _Toc415144511]imply, infer

Imply means to suggest or hint. 

Did her manner imply she was serious? 

Infer means to reach a conclusion by reasoning from facts or premises.

What do you infer from the last statement? 


[bookmark: _Toc415144512]in, into, in to

In normally indicates a fixed position. 

He is in the house. 

Into indicates movement toward a fixed position. 

He went into the house. 

In to is correct when in is an adverb. 

He turned himself in to the police. 

[bookmark: _Toc415144513]inconsistent

Inconsistent means not staying the same throughout. Inconsistent should be used with the preposition with.

Her findings were inconsistent with those of the dean. 

[bookmark: _Toc415144514]incorporate

Incorporate means to take in or include as part of the whole. Incorporate should be used with the preposition with or into. 

He will incorporate your suggestions into the master document. 

[bookmark: _Toc415144515]indexes, indices

Both indexes and indices are plural of index, an alphabetical list of names. Indexes is the preferred word. 

She provided nine indexes for review. 

[bookmark: _Toc415144516]indispensable 

Indispensable means absolutely necessary. This word is spelled with an a not i in the last syllable. 


[bookmark: _Toc415144517]individual

An individual is a single human being as distinct from a group, class, or family. It is acceptable to use individual when contrasting one person with an organization or body of people. 

How can one individual hope to rectify the evils of society. 

[bookmark: _Toc415144518]infant 

An infant is a child up to twelve months of age. 

She swaddled her infant daughter. 

[bookmark: _Toc415144519]in-service

In-service is an adjective and should be hyphenated.

She attended an in-service training session. 

[bookmark: _Toc415144520]insure, assure, ensure

Insure refers to insurance. 

The policy insures his vehicle. 

Assure means to set the mind at rest. 

The mutual fund manager assured her clients that their assets were safe. 

Ensure means to guarantee. 

To ensure data accuracy, several researchers validated the calculations. 

[bookmark: _Toc415144521]intra

Intra means on the inside or within. Hyphenate when it is used with a capitalized word or to avoid double vowels. 

He played intramural sports. 

There was an intra-atomic explosion. 


[bookmark: _Toc415144522]it’s, its

It’s is a contraction for it is. 

It’s a great day to play in the sun. 

The word its refers to possession.

The bear is clawing at its back. 


[bookmark: _Toc415144523]J


[bookmark: _Toc415144524]job site

Job site is a location where work takes place. Job site is two words and should NOT be hyphenated. 

He had to wear a hard hat at the job site. 

[bookmark: _Toc415144525]judgment 

Judgment does not have an e after the g. 

She was waiting on the final judgment. 

[bookmark: _Toc415144526]junior, senior

Junior refers to people who are young or younger. Spell out junior when referring to a class or its members. 

He was in his junior year at high school. 

Senior refers to people who are older or more experienced. Spell out senior when referring to a class or its members. 

He was a senior at El Dorado Hills High. 

Use the abbreviations Jr. and Sr. for a son or father only when using a full name. 


[bookmark: _Toc415144527]K


[bookmark: _Toc415144528]kick off, kick-off


A kick off generally indicates the start of an event. 

They waited for the home team to kick off the ballgame. 

Kick-off generally is used as an adjective. As such, the word should be hyphenated. 

She scheduled the kick-off meeting for next Tuesday. 

[bookmark: _Toc415144529]kindergarten, kindergartner

A kindergarten is a preschool educational environment traditionally based around playing, singing, practical activities such as drawing, and social interaction as part of the transition from home to school. 

The child started kindergarten shortly after her fifth birthday. 

A kindergartner is a child attending kindergarten. 

She was one of eleven kindergartners on the field trip. 


[bookmark: _Toc415144530]L


[bookmark: _Toc415144531]last, latest, past

Last means final. 

He ate the last piece of bread. 

Latest means the most recent. 

She was reading the latest edition of the magazine. 

Past means a period of time before the present. 

Her days of being a gymnast are in the past. 


[bookmark: _Toc415144532]Latino

A Latino is a person of Latin American origin or decent. 

First 5 California launched a marketing campaign in the Latino community. 

[bookmark: _Toc415144533]lay, lie

Lay means to put or place something somewhere. Lay always requires an object. 

I lay the paper by his plate every morning. 

Lie means to recline and does not require an object. 

I need to lie down. 

[bookmark: _Toc415144534]less, fewer

The word less generally is used for quantity or bulk. 

We need to buy less milk. 

The word fewer generally is used for individual or countable items. 

We reviewed no fewer than 500 applicants.  

[bookmark: _Toc415144535]liable

Liable means likely to do or to be something. Liable also may mean legally accountable. 

She is liable to walk the dog for three hours. 

[bookmark: _Toc415144536]liaison

A liaison is a close bond or connection, an interrelationship. Note the correct spelling of liaison. 

The outpatient liaison helped arrange my mother’s transition from the hospital to home. 


[bookmark: _Toc415144537]lie, lay

Lie means to recline and does not require an object. 

I need to lie down. 

Lay means to put or place something somewhere. Lay always requires an object. 

I lay the paper by his plate every morning. 

[bookmark: _Toc415144538]lifelong

Lifelong mean lasting or remaining in a particular state throughout a person's life. 

They have a lifelong friendship. 

[bookmark: _Toc415144539]life-size, life-sized

Life-size and life-sized can be used interchangeably to describe something of the same size as the person or thing represented. 

They admired the life-size statue of the discus-thrower. 

[bookmark: _Toc415144540]life span

Life span is the length of time for which a person or animal lives or a thing functions. Life span is two words and should not be hyphenated. 

The life span of a Great Dane is approximately five years. 

[bookmark: _Toc415144541]lifestyle

Lifestyle is the typical way of life of an individual, group, or culture. Lifestyle is one word and should not be hyphenated. 

They had a simple lifestyle. 

[bookmark: _Toc415144542]likely

Likely means inclined to do or to be something. 

She is likely to choose a university on the East Coast. 


[bookmark: _Toc415144543]linage, lineage

Linage means the number of printed lines. 

He paid for the entire linage of the three-page advertisement. 

Lineage means ancestry or decent. 

The prince came from a royal lineage. 

[bookmark: _Toc415144544]local

Local is defined as belonging or relating to a particular area or neighborhood. Do not use local community, local school district or local school board as local is redundant in these cases. Do use local educational agency (LEA). 

He supported the local educational agency. 

[bookmark: _Toc415144545]log off

Log off means to end a session on a computer by typing in the appropriate command. Log off is two words and should NOT be hyphenated. 

He had to log off before heading home. 

[bookmark: _Toc415144546]logon, log on

Logon is a noun and generally refers to a logon or login identification code. 

She could not remember her logon ID. 

Log on means to begin a session on a computer by typing in the appropriate command. 

Log on is two words and should NOT be hyphenated. 

She had to log on at the beginning of each work day. 



[bookmark: _Toc415144547]M


[bookmark: _Toc415144548]majority

Majority means more than half. 

She won the election by a majority vote of 61 to 50. 

[bookmark: _Toc415144549]makeup, make up

Makeup is defined as the composition or constitution of something. 

He had to identify the chemical makeup of the compound. 

Make up means to cause to exist or to happen.  

He had to make up the story to keep the children entertained. 

[bookmark: _Toc415144550]man, mankind

Avoid using man or mankind so as not to reflect gender bias. Instead, use humankind, people, and humanity. 

He wanted peace for all humankind. 

[bookmark: _Toc415144551]markdown, mark down

Markdown is a noun and is defined as a reduction in price. 

He waited until the manager announced the markdown on last year’s merchandise. 

Mark down is a verb and means to reduce the price. 

The manager intended to mark down Halloween merchandise on November 1. 


[bookmark: _Toc415144552]markup, mark up

Markup is the difference between the cost of a good or service and its selling price.

There was a 30 percent markup on shoes. 

Mark up is a verb and means to put a higher price on something or to write on something. 

He had to mark up the shoes another 10 percent. 

[bookmark: _Toc415144553]may, might, can

May indicates permission or possibility.

You may leave whenever you wish. She may be able to start work tomorrow. 

Might indicates probability, possibility, and permission. 

She might pass the class. 

Can indicates the ability, or power, to do something.
	
She can climb to the top of the ladder. He can run a half marathon.

[bookmark: _Toc415144554]mean

The mean is an intermediate figure between two extremes. 

The mean temperature of the day, with a high of 56 degrees and a low of 34 degrees, was 45. 

[bookmark: _Toc415144555]media

Media is a cultivation of conveyance, communication, or expression. Media usually is plural. 

Radio and television are electronic media. 

Media is singular when used to describe a collective group. 

The news media is resisting attempts to limit its freedom. 


[bookmark: _Toc415144556]mediate

Mediate means to intervene between people in a dispute in order to bring about an agreement or reconciliation. 

Wilson attempted to mediate between the powers to end the war. 

[bookmark: _Toc415144557]megabyte

The megabyte is a multiple of the unit byte for digital information.

She had several megabytes of music on her IPod. 

[bookmark: _Toc415144558]mid-range

The mid-range is the arithmetic mean of the largest and the smallest values in a sample or other group.

She was tasked with explaining to the class how to find the mid-range of their ages. 

Middle grades are the grades students attend between primary school and high school. 

She was not looking forward to middle school and the middle grades. 

[bookmark: _Toc415144559]middle grades

Middle grades are the grades students attend between primary school and high school. 

She was not looking forward to middle school and the middle grades. 


[bookmark: _Toc415144560]might, may, can 

Might indicates probability, possibility, and permission. 

She might pass the class. 

May indicates permission or possibility.

You may leave whenever you wish. 

She may be able to start work tomorrow. 

Can indicates the ability or power to do something.

She can climb to the top of the ladder. 

He can run a half marathon.

[bookmark: _Toc415144561]multi

Multi means more than one. Do NOT use a hyphen after multi. 

She ate a multi vitamin daily. 


[bookmark: _Toc415144562]N


[bookmark: _Toc415144563]native

Native refers to the fact that a person was born in a given location. 

She was a native Californian. 

[bookmark: _Toc415144564]Native American

Native Americans who live within the boundaries of the present-day United States (including the indigenous peoples of Alaska and Hawaii) are composed of numerous, distinct tribes, bands and ethnic groups, many of which survive as intact, sovereign nations. Do not describe Native Americans as American Indians. 

She lives with her Native American family on a reservation. 


[bookmark: _Toc415144565]none

The word none is defined as not any. None can be singular or plural. 

None are so blind as those who will not see. 

None is so blind as he who will not see. 

[bookmark: _Toc415144566]nonprofit, non profit, non-profit

Nonprofit means not making or not conducted primarily to make a profit. 

Charities and other nonprofit organizations help many people.

Nonprofit is one word and has no hyphen except in the case of repeated letters. 

[bookmark: _Toc415144567]non-negotiable

Non-negotiable is a modifier and always is hyphenated. 

Her terms were non-negotiable. 

[bookmark: _Toc415144568]norm

The norm implies a standard of average performance for a given group. 

The child was above his norm for his age in reading ability. 

[bookmark: _Toc415144569]note taker, note taking

A note taker is a person who takes notes. 

She was the note taker for their weekly meeting.  

Note taking is the act of taking notes. 

She enjoys note taking.  



[bookmark: _Toc415144570]O


[bookmark: _Toc415144571]occur, occurred, occurring, occurrence

The word occur means to happen or take place. 

I wonder when the next storm will occur. 

Occurred is the past tense of occur. 

The event occurred last January. 

Occurring means coming to pass or happening. 

Her headaches were occurring more frequently. 

An occurrence is an incident or event. 

Vandalism used to be a rare occurrence. 

[bookmark: _Toc415144572]officeholder

An officeholder is a person who holds public office. 

He has been an officeholder his entire professional life. 

[bookmark: _Toc415144573]offsite, off-site

Off-site means taking place or situated away from a particular site or premises. Always hyphenate off-site as it is a modifier. 

They attended an off-site meeting. 

Off site is a reference to a destination. The term off site does NOT require a hyphen when not used as a modifier.  

They were going off site for lunch. 


[bookmark: _Toc415144574]online

Online means controlled by or connected to another computer or to a network. Online always is one word. 

She was doing online research for her school project. 

[bookmark: _Toc415144575]on-site 

On-site means taking place or situated at a particular site or premises. Always hyphenate on-site. 

They attended an on-site meeting. 

[bookmark: _Toc415144576]oral 

The word oral is defined as by word of mouth; spoken rather than written. 

Their final exam was an oral presentation. 



[bookmark: _Toc415144577]P


[bookmark: _Toc415144578]paperwork

Paperwork is routine work involving written documents. Paperwork is one word and does not require a hyphen. 

She finished up her daily paperwork and headed home. 

[bookmark: _Toc415144579]part time, part-time

Part time is an adverb. 

She works part time. 

Part-time is an adjective. 

She has a part-time job. 


[bookmark: _Toc415144580]password

A password is a word or string of characters used for user authentication to prove identity or access approval to gain access to a resource. 

She asked the Help Desk if she could have a new password. 

[bookmark: _Toc415144581]PDF

PDF is an acronym for Portable Document Format. 

I asked her to send me a PDF of the file. 

[bookmark: _Toc415144582]people

People means human beings in general, or considered collectively. Typically, the word people is used to describe larger groups and persons for exact or smaller numbers. 

There were too many people at the conference for my liking.  

[bookmark: _Toc415144583]per pupil spending

Per pupil spending is defined as current expenditures per student. 

He reported on per pupil spending for the district. 

[bookmark: _Toc415144584]percent

A percent is one part in every hundred. Spell out percent when used in text. Use the percent symbol (e.g., % for tables and graphics). 

He received a 95 percent on his test. 

[bookmark: _Toc415144585]permissible

Permissible means permitted or allowed. Note the correct spelling above. 

Her leave was permissible. 


[bookmark: _Toc415144586]picture book, picture-book

A picture book combines visual and verbal narratives in a book format, most often aimed at young children. 

Each student brought their favorite picture book to kindergarten. 

Picture-book is an adjective and requires a hyphen. 

Theirs was a picture-book romance. 

[bookmark: _Toc415144587]Philipino

Philipino is the Tagalog-based official language of the Republic of the Philippines. 

She spoke fluent Philipino. 

Filipino is the ethnic group native to the islands of the Philippines.

She is Filipino. 

[bookmark: _Toc415144588]P.O. Box

P.O. Box is an abbreviation for post office box and should include periods when used in running text.

She mailed the letter to the last known P.O. Box. 

[bookmark: _Toc415144589]podcast

A podcast is a digital medium consisting of an episodic series of audio, video, radio, PDF, or ePub files subscribed to and downloaded through web syndication or streamed online to a computer or mobile device.

He tuned in to the podcast just before it ended. 


[bookmark: _Toc415144590]policymaker, policymaking

A policymaker is a person responsible for making policy, especially in government. 

She was a well-known policymaker in her community. 

Policymaking is high-level development of policy, especially official government policy. 

Policymaking is a mix of both science and art. 

[bookmark: _Toc415144591]postsecondary

Postsecondary is any type of school or training beyond the high school level. 

She was preparing to enter a postsecondary culinary school. 

[bookmark: _Toc415144592]post-test

A post-test is given to students after completion of an instructional program or segment and often used in conjunction with a pretest to measure their achievement and the effectiveness of the program.

Her post-test reflected a much higher score than her pre-test. 

[bookmark: _Toc415144593]prekindergarten, pre-K

Pre-kindergarten, also called pre-K is a classroom-based preschool program for children below the age of six in the United States.

She enrolled her daughter in the pre-kindergarten class. 

[bookmark: _Toc415144594]prenatal

Prenatal care is a type of preventive healthcare with the goal of providing regular care that allows doctors or midwives to treat and prevent potential health problems throughout pregnancy while promoting healthy lifestyles that benefit both mother and child. Prenatal always is one word and does not require a hyphen. 

She scheduled her third prenatal appointment for Thursday. 


[bookmark: _Toc415144595]preschool

Preschool is defined as of, pertaining to, or intended for a child between infancy and school age. 

She is so excited about starting preschool. 

[bookmark: _Toc415144596]presently

Presently is defined as soon, shortly, directly, quite soon, in a short time, in a little while, at any moment/minute/second, in next to no time, and before long. 

The hostess will be with you presently. 

[bookmark: _Toc415144597]president-elect

A president-elect is a person who has been elected president but has not yet taken office. 

John, the president-elect, will take office next week. 

[bookmark: _Toc415144598]principal, principle

A principal is the person with the highest authority or most important position in an organization, institution, or group. 

Mr. Smith is the school principal. 

A principle is a fundamental source or base of something. A principle is a fundamental truth or proposition that serves as the foundation for a system of belief or behavior or for a chain of reasoning. Principle always is a noun. 

The Heisenberg uncertainty principle in quantum mechanics implies that vacuum fluctuations are present in every quantum theory.

[bookmark: _Toc415144599]prior to

Prior to is a synonym of before and means in advance of or before something. 

She had to complete the application prior to taking the exam. 


[bookmark: _Toc415144600]privilege

A privilege is a right or benefit that is given to some people and not to others. Note the correct spelling.

It is a privilege to address the senior class as the valedictorian. 

[bookmark: _Toc415144601]problem solving, problem-solving

Problem solving is the process of working through details of a problem to reach a solution

She had a knack for problem solving. 

Problem-solving is an adjective and is a hyphenated modifier.  

He applied exceptional problem-solving techniques to solve the riddle. 

[bookmark: _Toc415144602]pupil

A pupil is a young individual enrolled in school. 

He was her finest pupil. 


[bookmark: _Toc415144603]R


[bookmark: _Toc415144604]recordkeeping

Recordkeeping is the discipline of controlling and governing what are considered the most important records of an organization throughout the records life-cycle, from inception to disposal. 

She was responsible for developing a recordkeeping retention policy. 

[bookmark: _Toc415144605]reevaluation

Reevaluation is an act or instance of evaluating or appraising.

Her reevaluation of her college choice resulted in changing her original decision. 


[bookmark: _Toc415144606]reteach

Reteach is to impart knowledge or instruction for on an occasion after the first teaching. This is one word and does not require a hyphen. 

After his accident, his mother had to reteach him how to tie his shoes. 



[bookmark: _Toc415144607]S


[bookmark: _Toc415144608]school-age

School-age is the age set by law for children to start attending school. This term requires a hyphen when used as a modifier. 

She was the mother of four school-age children. 

[bookmark: _Toc415144609]school children 

School children generally are children attending kindergarten to grade six. 

There were 46 school children on the bus. 

[bookmark: _Toc415144610]school day

A school day is a day when classes are held in a primary or secondary school. 

Today was a minimum school day. 

[bookmark: _Toc415144611]school site

A school site is the location of an institution for the instruction of children or people under college age.

She was visiting all of the school sites in Sacramento County. 

[bookmark: _Toc415144612]school teacher

A school teacher is a person who teaches school below the college level. 

She is a fifth grade school teacher. 


[bookmark: _Toc415144613]school time

School time is the period of instruction in a school; the time period when school is in session. Jaime—the old guide reflects schooltime as one word. Grammar check and the online definitions reflect school time as two words as I have included here. 

The students had six hours of school time each weekday. 

[bookmark: _Toc415144614]school year

A school year is an academic term or a portion of an academic year, the time during which an educational institution holds classes. The adopted schedules vary widely. 

The San Juan Unified school year runs from August through June. 

[bookmark: _Toc415144615]semi, bi 

Semi usually means half. 

Semiweekly meetings occur twice a week. 

Bi usually means two. 

Biweekly meetings occur every two weeks. 

These prefixes often are misunderstood. Define them at the first usage.

[bookmark: _Toc415144616]service-learning

Service-learning is a method of teaching that combines classroom instruction with meaningful community service. This form of learning emphasizes critical thinking and personal reflection while encouraging a heightened sense of community, civic engagement, and personal responsibility.

She was enrolled in a service-learning program for agriculture. 


[bookmark: _Toc415144617]sign-off, sign off

A sign-off is a noun that means the conclusion of a letter, broadcast, or other message. Sign-off also means personal approval or authorization. 

That was their daily sign-off on the TV show. 

She gave the report her final sign-off. 

Sign off is the verb form of ending a broadcast or providing approval or authorization. 

He had to sign off at the end of each broadcast. 

She had to sign off on every purchase order. 

[bookmark: _Toc415144618]Social Security

Social Security in the United States is a federal insurance program that provides benefits to retired people and those who are unemployed or disabled.

He was two years shy of being able to apply for Social Security benefits. 

[bookmark: _Toc415144619]socioeconomic

Socioeconomic is defined as of, pertaining to, or signifying a combination of social and economic factors. 

First 5 California conducted a socioeconomic study of California children from birth to five years of age.  

[bookmark: _Toc415144620]spreadsheet

A spreadsheet is an electronic document in which data is arranged in the rows and columns of a grid and can be manipulated and used in calculations. 

We color-coded the Excel spreadsheet of all of our trip expenses. 

[bookmark: _Toc415144621]staff

Staff are all people employed by a particular organization. Staff can be either singular or plural. To avoid confusion, use staff members with a plural verb. 

She invited her staff to lunch. 

Staff members were available to assist the customers. 

[bookmark: _Toc415144622]standards-based

In education, the term standards-based refers to systems of instruction, assessment, grading, and academic reporting that are based on students demonstrating understanding or mastery of the knowledge and skills they are expected to learn as they progress through their education.

In the United States, most standards-based approaches to educating students use state learning standards to determine academic expectations and define proficiency.

[bookmark: _Toc415144623]statewide

Statewide means extending throughout a specific US state. 

There was a statewide ban on bond fires given the current drought. 

[bookmark: _Toc415144624]supposed to NOT suppose to 

Supposed to means intended to, believed to, expected to. 

This pill is supposed to relieve my pain. 

Suppose is a verb meaning to think or ponder. 

Do you suppose there is life on other planets? 


[bookmark: _Toc415144625]T


[bookmark: _Toc415144626]teamwork

Teamwork is the combined action of a group of people, especially when effective and efficient.

Their teamwork resulted in a quality product they proudly presented to the audience. 

[bookmark: _Toc415144627]textbook

A textbook is a book used as a standard work for the study of a particular subject.

He left his math textbook at school. 

[bookmark: _Toc415144628]than, then

The word than refers to comparison. 

He is taller than she.

The word then refers to a subsequent event. 

I was living in Hawaii then. 

[bookmark: _Toc415144629]that, which

That commonly introduces a clause that cannot be omitted without a change in the meaning of a sentence. Do not set of that by commas. 

The book that I left on the bus was returned to me by a stranger. 

The word which often introduces a clause that can be omitted without changing a sentence’s meaning. The clause should be set off by commas.  

The book, which I now read only at my leisure, was returned to me by that kind stranger. 

[bookmark: _Toc415144630]their, there, they’re

The word their is defined as belonging to or associated with the people or things previously mentioned or easily identified.

Her mean words had lost their power to sway her rival. 

The word there is defined as in, at, or to a place or position. 

He will be there in ten minutes. 

The term they’re is a contraction of they are. 

They’re on their way to the picnic now and should be there shortly. 


[bookmark: _Toc415144631]then, than

The word then refers to a subsequent event. 

I was living in Hawaii then. 

The word than refers to comparison. 

He is taller than she.

[bookmark: _Toc415144632]through, threw

Through is a preposition. 

He jumped through the hoop. 

Threw is a verb. 

He threw the ball to the catcher. 

[bookmark: _Toc415144633]time frame

A time frame is a specified period of time in which something occurs or is planned to take place.

She gave me a two-hour time frame to stop by and look at the photos. 

[bookmark: _Toc415144634]time line, timeline 

A time line is a graphic representation of the passage of time as a line.

They drew a time line on the white board of the important events that occurred during the crime. 

A timeline is used for a schedule of events and procedures. 

She provided a timeline for the project. 


[bookmark: _Toc415144635]timesaving

Timesaving means reducing the amount of time needed to do something.

He had no idea this timesaving idea would turn into a profitable business. 


[bookmark: _Toc415144636]toll-free

The term toll-free means without a charge. A toll-free call is a long-distance telephone call without a toll. Toll-free is a modifier and always is hyphenated. 

She made the toll-free call to order the textbooks. 

[bookmark: _Toc415144637]toolbox

A toolbox is a box or container for storing tools. Toolbox is one word 

He always carried the toolbox in his trunk. 

[bookmark: _Toc415144638]tool kit

A tool kit is a set of tools, especially one kept in a bag or box and used for a particular purpose. Tool kit is two words without a hyphen. 

She kept her crafting tool kit in the den.

[bookmark: _Toc415144639]toward, towards

The word toward is defined as in the direction of something or someone. Toward is preferred to towards with the s. 

She walked toward the door. 

[bookmark: _Toc415144640]twenty-first century

The 21st century is the current century of the Anno Domini era or the Common Era, in accordance with the Gregorian calendar. It began on January 1, 2001, and will end on December 31, 2100.

We are living in the 21st century.  


[bookmark: _Toc415144641]U


[bookmark: _Toc415144642]unanimous

Unanimous means the agreement and consent of all. Thus, it is redundant to use completely unanimous. 

They unanimously elected George the most valuable player of the game. 
[bookmark: _Toc415144643]under way, underway 

Under way is an adverb and means in progress. 

Plans are under way to redecorate the school cafeteria.  

Underway is an adjective. 

The Air Force uses underway fueling on some of its missions. 

[bookmark: _Toc415144644]up close

Up close is defined as at close range. This word can be an adverb or adjective. 

On the safari, she saw a rhinoceros up close. 

[bookmark: _Toc415144645]update

Update can be used as a noun or verb. The verb form of update means to make something more current or modern, 

She updated the First 5 California Absence Policy. 

The noun form of update means to provide someone with new or more current information. 

The Communication Officer presented an update on the hostage situation. 

[bookmark: _Toc415144646]upon

Upon is a more formal term for on. Avoid using upon. Replace with on. 

She stood on the doorstep and rang the doorbell. 

[bookmark: _Toc415144647]up-to-date, up to date

Up-to-date is an adjective and means incorporating the latest technology or trends. 

Their baby was born in a modern, up-to-date hospital. 

Up to date is an adjective that means incorporating and aware of the latest information. 

This book will keep you up to date. 

[bookmark: _Toc415144648]use, utilize

Both use and utilize mean to make practical use of something. Utilize generally is unnecessary and should be replaced with use. 

Please, may I use your pencil? 

[bookmark: _Toc415144649]user-friendly

The adjective user-friendly is defined as easy to use or understand. 

Quickbooks 2013 is more user-friendly than the 2009 software. 

[bookmark: _Toc415144650]user name

A user is a person who uses a computer or network service. A user often has a user account and is identified by a user name. 

I forgot my user name and password and had to contact the Help Desk. 


[bookmark: _Toc415144651]V


[bookmark: _Toc415144652]verbal

Verbal means related to or in the forms of words.  

The teacher gave her student a verbal warning based on the child’s behavior. 

[bookmark: _Toc415144653]versus

Versus is a preposition that means opposed to or against. 

The pesticides used in organic farming number about five versus hundreds used in conventional agriculture.

[bookmark: _Toc415144654]vice president

A vice president is an official or executive ranking below and deputizing for a president.

We had the pleasure of meeting the vice president of marketing last week. 


[bookmark: _Toc415144655]videotape

A videotape is a magnetic tape for recording and reproducing visual images and sound.

It is evident that videotape is being replaced by compact disc technology. 


[bookmark: _Toc415144656]W


[bookmark: _Toc415144657]webcast

A webcast is a media presentation distributed over the Internet using streaming media technology to distribute a single content source to many simultaneous listeners and viewers. A webcast may either be distributed live or on demand. Essentially, webcasting is broadcasting over the Internet. 

I listened in on a fascinating webcast discussing early education opportunities. 

[bookmark: _Toc415144658]webinar

A webinar is a seminar or other presentation that takes place on the Internet, allowing participants in different locations to see and hear the presenter, ask questions, and sometimes answer polls. 

First 5 California conducts county-focused webinars. 

[bookmark: _Toc415144659]webpage

A webpage is a web document that is suitable for the World Wide Web and the web browser. A web browser displays a web page on a monitor or mobile device. The web page is what displays, but the term also refers to a computer file, usually written in HTML or comparable markup language, whose main distinction is to provide hypertext that will navigate to other web pages via links.

She was able to navigate from the First 5 California website to the Services and Support webpage. 


[bookmark: _Toc415144660]website

A website is a location connected to the Internet that maintains one or more pages on the World Wide Web. 

You may find information about early education opportunities on the First 5 California website. 

[bookmark: _Toc415144661]well-being

Well-being or welfare is a general term for the condition of an individual or group. 

The teachers were concerned with the emotional well-being of their students. 

[bookmark: _Toc415144662]which, that

The word which often introduces a clause that can be omitted without changing a sentence’s meaning. The clause should be set off by commas.  

The book, which I now read only at my leisure, was returned to me by that kind stranger. 

That commonly introduces a clause that cannot be omitted without a change in the meaning of a sentence. Do not set of that by commas. 

The book that I left on the bus was returned to me by a stranger. 

[bookmark: _Toc415144663]word of mouth, word-of-mouth

Word of mouth is a noun defined as the passing of information from person to person by oral communication. 

I learned about the First 5 California website by word of mouth. 

Word-of-mouth is an adjective and is used to describe a noun. Only use the hyphens with the modifying adjective form of this term. 

Her word-of-mouth communication tipped off the students that there would be a pop quiz. 


[bookmark: _Toc415144664]workbook

A workbook may be a student's book containing instruction and exercises relating to a particular subject or a single file containing several different types of related information as separate worksheets. 

The students were instructed to place their workbooks on their desktops. 

[bookmark: _Toc415144665]workday

A workday is the time during the day during which one works. 

It would be great if we had only a five-hour workday. 

[bookmark: _Toc415144666]workforce

A workforce is defined as the people engaged in or available for work, either in a country, an area, or in a particular company or industry.

The U.S. workforce consists of professionals of all levels of education, experience, and expertise. 

[bookmark: _Toc415144667]workgroup

A workgroup generally is two or more individuals who routinely function like a team, are interdependent in achievement of a common goal, and may or may not work next to one another or in the same department.

She led the workgroup responsible for redesigning the website. 

[bookmark: _Toc415144668]workload

Workload is the amount of work to be done by someone or something. 

He was assigned three deputies to ease his workload. 

[bookmark: _Toc415144669]work order

A work order or job order (sometimes job ticket or work ticket, as it often has some type of ticket attached) is an order received by an organization from a customer or client, or an order created internally within the organization. 

I initiated a work order with the Help Desk for a software update. 


[bookmark: _Toc415144670]workplace

A workplace is a place where people conduct business or work (e.g., an office or a factory). 

Today is designated bring your child to the workplace day. 

[bookmark: _Toc415144671]work plan 

A work plan is a detailed accounting of how an individual or group proposes going about accomplishing a specific task, approaching a project, or pitching a new business concept.

The Communications director drafted a work plan for the upcoming marketing campaign. 

[bookmark: _Toc415144672]worksheet

Worksheet commonly refers to a sheet of paper with questions for students and places to record answers. The term also may refer to a single array of data in spreadsheet, software, or an informal piece of paper that an accountant uses to record information.

The children completed their math fact worksheets. 

[bookmark: _Toc415144673]workshop

A workshop usually is a brief, intensive, educational program for a relatively small group of people that focuses especially on techniques and skills in a particular field. 

First 5 California hosted a workshop for new parents focused on early childhood education techniques. 

[bookmark: _Toc415144674]work site

A work site is an area where work takes place. 

They had to wear hardhats at the work site. 


[bookmark: _Toc415144675]Y


[bookmark: _Toc415144676]yearlong

Yearlong is defined as lasting or continuing throughout the year. 

They conducted a yearlong campaign to raise the awareness of breast cancer. 

[bookmark: _Toc415144677]year-round

Year-round is an adjective or an adverb and is defined as happening or continuing throughout the year. 

Our children attend year-round school. 

your, you’re 

Your is a pronoun. 

Your sister is in the elevator. 

You’re is a contraction of you are. 

You’re doing a spectacular job with the team. 

[bookmark: _Toc415144678]youth

Youth is the plural form of youths. This group includes young people aged thirteen through seventeen years. After eighteen, use man or woman. 

He was the mentor for a junior class youth group. 
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